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getting started

Use information in this section to install WinMark Pro software and
create a sample drawing to be laser marked.

This section contains the following information:

Introduction — lists new features incorporated into version 2841 and
describes computer system requirements, software upgrades, and
technical support.

Installation — explains how to install WinMark Pro.

Starting WinMark Pro — explains how to start the software and set
initial operating parameters.

Drawing Editor — describes WinMark Pro’s drawing environment.

Creating a drawing — steps through the creation of a sample drawing.

Synrad WinMark Pro®user’s guide 14



getting started

Introduction

Welcome to SYNRAD’s WinMark Pro® software— software that gives you the power to
create text and bar code images or import professional graphics that can then be laser
marked on your product from a Windows 95 or Windows 98 desktop. In addition to
creating virtually any image, WinMark Pro is also capable of controlling every aspect of
the laser marking process including incrementing serial numbers, changing laser
parameters, and interfacing with parts handling equipment.

New features
WinMark Pro software, Version 1.0.6 build 2856, supports SYNRAD’s new Fenix and
FH Series marking heads and is also backward compatible with DH and SH Series
heads. New software features include:

Improved marking speed Better circle and rotated image quality

Spot Marking Style for glass marking New interface for object delays

Queries Fenix/FH heads for errors

System requirements

In order to install and run WinMark Pro software, your computer system must meet the
following minimum requirements:

Windows 95/98 operating system Pentium 90MHz or faster (min 486/66)

16-megabytes (MB) RAM 10-MB hard drive space
SVGA monitor (800 x 600 display)

Upgrades

Unlike many other software packages that cost hundreds of dollars to upgrade,
WinMark Pro upgrades are made available free of charge on the WinMark Pro
web site. Users should periodically check our web site at http://www.winmark.com
to download the latest version of WinMark Pro software.

Technical support

Call 1-800-SYNRADI between the hours of 8:30 A.M. to 5:00 p.M. PST or visit the
WinMark Pro web site at http://www.winmark.com.
1 2 Synrad WinMark Pro®user’s guide
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Installation

inventory

The WinMark Pro software package includes the following items (shown in Figure 1-1):

Two WinMark Pro installation disks
Two WinMark Pro File Import Filters disks
One Hardlock

7

|
Disk #1 Disk 35
5=

Figure 1-1 WinMark Pro inventory

Hardlock

A Hardlock is installed on the printer port to prevent unauthorized use of WinMark
Pro software. If the Hardlock is not installed, WinMark can still be opened and files
can be created, but marking will not be enabled. Each version of software, WinMark
Pro and WinMark Lite, has its own specific Hardlock (WinMark Lite Hardlocks are
laser marked “Lite” and their serial numbers end with an “L”).

Install the Hardlock by performing the following steps:

Locate the Hardlock inside the plastic sleeve in the front of this User’s Guide.
Disconnect the printer cable from the back of your computer.

Connect the Hardlock to the printer port.

A WO N =2

Connect the printer cable to the Hardlock.

Synrad WinMark Pro®user’s guide 1=



getting started

Installation

WinMark Pro

To install WinMark Pro on your computer:

1 Locate the WinMark Pro installation disks inside the plastic sleeve in the front of
this User’s Guide.

Exit all programs.
Insert WinMark Pro Disk 1 into drive A.
Click the Start button on the taskbar and then click Run.

Type A:\setup in the Run dialog box.

o 0 » N

Click OK, then follow the on-screen instructions.

WinMark Launcher

As part of the software installation, WinMark Launcher is placed in the WinMark
folder and a shortcut is placed on the desktop. The Launcher allows operators to open
existing .mkh files for marking without opening WinMark Pro’s Drawing Editor. Using
WinMark’s Startup Options command, WinMark Launcher can also be configured to
load a specific file and start automatically when your computer is powered up.

M1a Synrad WinMark Pro®user’s guide
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Installation

Digital Scope

DigScope.exe is a stand-alone program included in the WinMark folder. Digital Scope
can test individual inputs and outputs, turn the laser beam on or off, or adjust the laser’s
output power level (Refer to Figure 1-2). This “manual” control is especially useful
when testing or troubleshooting I/O connections through the digital fiber optic link.

Note: Digital Scope’s base address, 816, is the decimal equivalent of the Fiber Link
Controller Card’s base hexadecimal address of 330.

|*\synrad Digital 170 Scope [<]

Bas\Address |315

Bitz o1 2 3 45 & 7

Output (i [ iy T

Input I_I_I_I_I_I_I_I'N
|

Laser Duty Cycle |0 I Toggle Lase l
. N

SYNRAD

2 4

Figure 1-2 Digital Scope display

1 Input — “buttons” pop-up to indicate an input is active.

2 Slider — Drag the slider to set laser power between 0—100%. Power output is
displayed in the Laser Duty Cycle box.

3 Output — press “buttons” to activate an output.
4 Toggle Lase — turns the laser On. Press again to toggle the laser Off.

Note: Close Digital Scope before attempting to operate the Marking Head using
membrane panel pushbuttons or WinMark Pro software commands.

Note: If the Fast Acting Safety Interlock (FASI) feature is active, then input #3 on
FH Series or Fenix marking systems, or input #5 on DH Series systems, must be
active (high) before the laser will fire.

Synrad WinMark Pro®user’s guide 1s
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Installation

File lImport Filters

WinMark Pro’s File Import Filters allow you to import a wide variety of graphic file
formats. Installation of the filters is optional and can be omitted if you do not intend
to import graphics files from other applications.

To install File Import Filters, follow the steps below:

1 Locate the File Import Filters disks inside the plastic sleeve in the front of this
User’s Guide.

Insert File Import Filters Disk 1 into the drive A.
Click Start on the taskbar and then select Run.

Type A:\setup in the Run dialog box.

a » N

Click OK and follow the on-screen instructions.

Un-installing WinMark Pro

If you decide to remove WinMark Pro software:

Click the Start button on the taskbar.
Select Programs and then locate the Synrad WinMark folder.
Click the Uninstall Synrad WinMark icon.

A WO N <

Follow the on-screen instructions.

Te Synrad WinMark Pro®user’s guide
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Starting WinMark Pro

Basic concepts

A mark file is created by placing text or graphic objects, or importing graphic files, into
a drawing. Each individual object, including the Drawing Canvas itself, has its own
unique set of properties whose default settings can be modified by the user. Each class of
objects, all text objects for example, have specific sets of properties where each property
defines some characteristic of that object. All objects also share a set of general proper-
ties that define their position and how the laser transfers that object’s image to the
workpiece. This ability to precisely control marking output by customizing drawing and
object properties is one of the strengths of WinMark Pro software.

Starting the software

Start WinMark Pro by double-clicking the Shortcut To WinMark icon on your
desktop, or follow these steps:

1 Click Start on the taskbar.
2  Select Programs and then locate the Synrad WinMark folder.
3  Click the Synrad WinMark icon.

During startup, WinMark Pro checks to see if a Hardlock is installed on the computer.
If a Hardlock is found, WinMark starts the appropriate software version (Pro or Lite)
that matches the Hardlock.

If no Hardlock is installed on the computer, a dialog box appears (Figure 1-3) prompt-
ing you to select the WinMark version you wish to run. Current WinMark Pro users
should always specify the Pro version. New users should choose the version that
matches their Hardlock.

Note: WinMark Lite can NOT read or mark files created in WinMark Pro.

No Hardware Lock

The required hardware Iock is not attached to the:
computer. Al marking output is disabled.

Chonse which wersion of 'Wink ark you wish to use

(Fenix)

Mote: Wintark Lite can MOT read \Wwinkark Pro files!

Figure 1-3 No Hardware Lock dialog box

Synrad WinMark Pro®user’s guide 1=
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Starting WinMark Pro

4 The first time WinMark Pro opens after a new installation, the Lens Selection
dialog box (Figure 1-4) appears and prompts you to enter the size of the currently
installed focusing lens. The lens size entered determines the dimensions of the
Drawing Canvas’s imageable area.

Make a lens selection and then click OK.

Lens Selection ]

Selsct your lens

The focal length of the lens is printed on the lens
1im, an the bettem of the marking head

I~ Dther lens: manually specity field size (in mm)

Haorizantsl |134 Wertical [155
0K Cancel

Figure 1-4 Lens Selection dialog box

Changing the lens size

If you replace the focusing lens on your marking head with a lens having a different
field size you will need to enter the new lens size so that WinMark Pro properly scales
the drawing when marking.

To change lens settings, perform the following steps:
From the Tools menu, select General Settings.

In the WinMark Settings dialog box, click the Application Settings tab.
Click Lens, and then click the ellipsis (...).

A WO N =

In the Lens Selection dialog box (Figure 1-4), select the lens matching the one
currently installed on your Marking Head.

Note: When using the FH Series Marking head, select a lens from the Fenix
lens group.

5 Open a new drawing to display a Drawing Canvas showing the new field
dimensions.

1s Synrad WinMark Pro®user’s guide
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Starting WinMark Pro

Setting measurement units

You can set WinMark Pro to display all measurements in inches, centimeters, or

millimeters.

To change measurement units, perform the following steps:

From the Tools menu, select General Settings.

In the WinMark Settings dialog box, click the Application Settings tab.

From the drop-down list, select the appropriate measurement units.

1

2

3  Click Show Units Type (Figure 1-5), and then click the arrow.
4

5

Click Apply to apply the change, and then click OK.

WinMark Settings [x]

Application Settings | Drawing Defaults | Dbject Defauls |

pplication settings are the global properties of the application. Madify these properties
to modify differant aspects of the behavior of twinkd ark.

Lens -
Launcher Modify Passward

ShowlnisToe [
Show Camman Praps

Sl B LCentimeters

Biauiis Ailimeters

|Grid Dffset X 0000 in

|Grid Difset 0000 in

Giid Spacing 1000 in L
Snap Ta Giid Ves

Hudge Spacing 0.1000in

Show Tap Fuler Ves

Show Lelt Fuler Yes =
Show Units Type iI
Spesifies the unit type (inches. centimeter, or milimeters] for all measurement

displaus.

El

0K | Cancel | b

Figure 1-5 Changing “Show Units Type”
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Drawing Editor

Main Window

To aid creation of mark files, the Drawing Editor’s Main Window (Figure 1-6) is
divided into several distinct areas: the Tool Box, Drawing Canvas, Slide Bar, Object
List, Property List, Property Information Window, and Status Bar.

Slide Bar Object List
[ winkak Pro[uniileat] R
%) File Edit Objscts Yiew Took Window Help =18 ]
D|z|@@| (@] | 2|0 E2{=] N @] [F ]

Lo -2.00 -1.00 0.oo 1.00 z.on 300 ’ j‘
Losin e llnattanadlnnutnnadbown b o N

=

-3.00

Automation | Marking | Fomat | &1 |
Tool Box —|

-2.00

! O Before Matk Session | Undefined
Set Digital Before Piece. | ——
[ Wil Dighal Befare Fiece

: On Before Mark Fiece

! Sel Digial Before Mark

' Wit Digital After Piecs

! O After Mk Piece Urdsfined

-1.00

0.oo
I R AR FURN FUI RSN BTN ST BT ST B P
|
|
f
|
|
|
|
|
f
|
|

' Set Digital After Mark
! O After Mtk Sassinn Urdsfined
o |
- I
g |
& I
I
g : ’ ¥ 4
S o o [
Fieady
Drawing Canvas Status Bar

Figure 1-6 WinMark Pro Main Window
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getting started

Drawing Editor

Tool Box

Icons in the Tool Box (Figure 1-7) represent the tools you use in WinMark Pro. To
select a tool, place the cursor over the tool and click the left mouse button. The cursor
changes into the appropriate icon. When drawing with a Line, Freehand, Rectangle, or
Circle tool, press and hold the left mouse button while dragging to create the desired
size, length, or direction and then release the mouse button.

[o[o]e[[-[o ]|

FIBE

Figure 1-7 Tool Box

The following tools are available in the Tool Box:

* Selection Tool - selects or deselects objects on the Drawing Canvas. Click
the left mouse button to select an object. Hold the left mouse button and drag
to select multiple objects within the selection area, or hold the cTRL key and left click
objects to add them to the selection. Click on a blank section of the drawing to
deselect all objects. Click the Selection Tool icon to regain the arrow cursor after using
a tool such as the Zoom Tool, which does not default to an arrow cursor.

J:' Z00m Tool - zooms in or out of the Drawing Canvas. After selecting the
Zoom Tool, click the left mouse button to zoom in; click the right mouse
button to zoom out. The “zoomed” image is centered on the position of the Zoom Tool
when you click. To enlarge a specific area, hold the left mouse button and drag to
define the zoom area.

A Text Tool - places text in the drawing. Click the Text Tool on the Drawing
—— Canvas to set an insertion point and open the Text Caption Editor dialog box.
After entering text in the dialog box, you can select the text box to modify its position
or change text attributes such as font type or size using the Property List.

Synrad WinMark Pro®user’s guide M1



getting started

Drawing Editor

A Line Tool — draws straight point-to-point lines. If Snap to Grid is activated,
——1 the line’s origin and destination endpoints are snapped to the nearest grid line
intersection.

Z' Freehand Tool - draws irregular, freechand lines. If Snap to Grid is activated,
——1 any curves drawn are snapped to the nearest grid line and intersection.

(| Rectangle Tool — draws square or rectangular objects. If Snap to Grid is
——' activated, lines and corners are snapped to the nearest grid line and
intersection.

G Circle Tool - draws circular objects. If Snap to Grid is activated, the circle’s
——1 outer diameter is snapped to the nearest gridline.

it Ber Code Tool - places a bar code in the drawing. Click the Bar Code Tool
——1  then click in the drawing to set an insertion point. Barcode Number is high-
lighted on the Format tab. Type the characters you want converted into bar code form.
Maodify bar code position or change attributes such as Barcode Style on the Format tab.

E 2D Data Matrix Code Tool - places a 2D Data Matrix code in the

——1 drawing. Click the 2D Data Matrix Code Tool then click in the drawing to set
an insertion point. 2D Barcode Text is highlighted on the Format tab. Type the charac-
ters you want converted into Data Matrix form. Modify or change attributes such as 2D
Data Matrix Code Inverted on the Format tab.

(1 Spot Tool - places spots on the drawing that correspond to the diameter of
——'the laser beam. Spots are useful as guides for aligning the laser beam. If the
correct power level and beam duration is specified in the Property List, spots can be used
to perforate, or drill, the workpiece.

[aad Image Import Tool - imports graphic image files into the drawing. Click
——1  the Image Import Tool to open the Open dialog box. Select a file type, click on
the file to import, and then click Open to place the graphic on the Drawing Canvas.

M= Synrad WinMark Pro®user’s guide
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Drawing Editor

Drawing Canvas

The Drawing Canvas is the area where graphics and text objects are arranged to create
a mark file that can then be transferred to the workpiece. The center white area on the
Drawing Canvas, shown in Figure 1-8, is the optimal imageable area for the currently
installed lens. The yellow shaded border indicates the maximum marking field of the
lens. Objects placed in the shaded area, especially near the corners, may exhibit a slight
degradation in mark quality.

Drawing Canvas dimensions correspond to the focusing lens size entered in the Lens
Selection dialog box. The dotted Origin Lines running across the canvas identify the
horizontal and vertical centers of the work area. The intersection of the Origin Lines
(X=0, Y=0) can be used to align parts with the drawing image to be marked.

Maximum Marking
Area (Shaded Yellow)

a_ &0 0.00 0 50 1.00 1.50
™~ |

\..m..‘ ..m..‘ ..m..‘\..m. llrndtnnadlone oo
E | 2l Typical Marking
B | ¥ Area

Kl

Figure 1-8 Drawing Canvas
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Drawing Editor

Slide Bar

Grab the Slide Bar with the Pointer and pull to the left or right to change the
horizontal display area of the Drawing Canvas and Object/Property windows.

Object List

Each object placed on the Drawing Canvas is automatically added to the Object List
and is associated with a set of object properties; for example, drawing a single rectangle
on the canvas creates an entry in the Object List named Polylinel. Each type of object
has a specific set of properties that defines some characteristic of that object and objects
also share a set of general properties that define their position and how the image
transfers to the workpiece. The Drawing Canvas also contains a unique set of object
properties and always appears first in the Object List as Drawing.

Property List

The Property List consists of five tabs: Special, Automation, Marking, Format, and All
that group sets of object properties by function. When an entry on the Object List is
selected, the properties that affect that entry appear on the tabs in the Property List
window. Those individual properties can then be edited.

Property iInformation window

When a property is selected from the Property List tab, a description or explanation of
that property appears in the Property Information window.

Status Bar

The Status Bar displays information about tools and their current XY position, as well
as information about icons on the toolbar.

T 1a Synrad WinMark Pro®user’s guide
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Creating a drawing

Opening a new drawing

WinMark Pro creates a new drawing with a blank Drawing Canvas each time it opens.
If WinMark Pro is already open, select New from the File menu.

Iimporting a graphic file

1 Select the Image Import Tool ( E‘) or on the File menu, click Import. The Open
dialog box appears, asking you to locate a file for import. For illustration purposes
we will import a sample file included with WinMark Pro.

Note: Remember to first load the File Import Filters from disk or download and
install them from the WinMark web site.

2  In the WinMark folder, double-click the Samples folder.
3  In the Samples folder, double-click the SampleImports folder.
4 In the Files of type drop-down list, select (*.eps) Encapsulated PostScript.

5 Select the Synrad.eps file and click Open. The SYNRAD logo appears on the
Drawing Canvas (Figure 1-9).

il — |

Figure 1-9 Sample imported graphic file

Synrad WinMark Pro®user’s guide 1as
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Creating a drawing

Positioning a graphic
1 Use the Selection Tool to click the SYNRAD logo to select it.

Note: When an object is selected, a bounding outline appears around the selected
object or objects.

N

From the Objects menu, click Transformations.

3  In the Object Transformations dialog box (Figure 1-10), change the X position
to —1, Y position to —1, and New Width to 1.

Object Transformations

3 position * position Referarence Pt
[roodin =000n = [Toplen =]

~Siging T
¥ Maintain Aspect Ratio

Cunent \Width

New Width

Scale

|1 0000 in
Current Height

1= |1 0000 in
New Height

:;”muz

Scale

Lkl Lk

|0 5437 in

1= |0 5437 in

:;”muz

Riotation T i
’V Enter Retstior, [J dog =
| ok | cancel |
b

Figure 1-10 Object Transformations dialog box

4 Click Apply. The size of the logo is now one inch wide but retains the correct
height proportion because the Maintain Aspect Ratio check box is selected. Also
the left edge is one inch to the left of the vertical centerline (X position = —1)
and its top is one inch above the horizontal centerline (Y position = —1).

Experiment with setting different values in the Object Transformations dialog box.
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Creating a drawing

Adding text

1 Select the Text Tool (E‘) from the Tool Box.

2  DPosition the cursor on the Drawing Canvas and click the left mouse button to set
an insertion point. The Text Caption Editor dialog box appears.

3  In the Text Caption Editor dialog box (Figure 1-11), type the words: Sample Text.

Text Caption E ditor

Sample Text =

Figure 1-11 Text Caption Editor dialog box

4 Click OK. Sample Text appears on the canvas within a bounding outline.

Experiment with changing different text parameters such as fonts and sizes on the
Format tab.

Adding other objects

Rectangles and circles

1 Select the Rectangle Tool (EI) or Circle Tool (©]) from the Tool Box.

2 Position the cursor on the Drawing Canvas. Click and hold the left mouse
button to set a starting point, then drag the mouse to define the object’s size
and shape.

If an exact dimension is required, set the object’s width and height in the Object
Transformations dialog box.

Synrad WinMark Pro®user’s guide M1z



getting started

Creating a drawing

Bar codes

Select the Bar Code Tool (M) from the Tool Box.

Position the cursor on the Drawing Canvas and click the left mouse button to
set an insertion point.

In the Property List, click the Format tab and enter information in the Barcode
Number field.

Select the appropriate Barcode Style.

2D Data Matrix codes

1 Select the 2D Data Matrix Code Tool (E&]) from the Tool Box.

2  DPosition the cursor on the Drawing Canvas and click the left mouse button to set
an insertion point.

3  In the Property List, click the Format tab and then in the 2D Barcode Text field,
click the ellipsis (...).

4 Enter data in the Text Caption Editor dialog box and click OK.

Spots

1 Select the Spot Tool (2] from the Tool Box.

2  DPosition the cursor on the Drawing Canvas and click the left mouse button to set
an insertion point.

3  In the Property List, click the Format tab and enter a Spot Lase Duration time in

milliseconds (ms).

This section has demonstrated just a few of the tools and features available in
WinMark’s Drawing Editor. The next chapter, “Operation”, contains three sections.
Marking parts steps through the process of laser marking a drawing. Marking basics
describes how marks are created for different types of text and graphics objects and
explains the most important parameters controlling mark speed and quality. Automation
basics discusses how WinMark Pro’s automation features work with automated parts
handling equipment.
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Use information in this section to begin laser marking.
This section contains the following information:

Marking parts — explains how to mark single pieces or parts in
batches.

Marking basics — explains how font selections and graphics file
formats affect mark speed and quality.

Automation basics — describes the basic procedures in connecting to
automated parts handling equipment.
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Piece marking

For manufacturing processes that produce parts one at a time, piece marking may be
the most appropriate method of marking. The following procedure steps you through
a sample parts marking session. This procedure may not meet your particular needs
but you can modify it by specifying different parameters.

1 Use the Drawing Editor to create a file with text, artwork, or imported graphics to
be marked.

2  With the object or objects selected, set marking Velocity, Power, and Resolution
on the Marking tab.

3 Position the cursor over a blank area of the Drawing Canvas and click the left
mouse button or select Drawing in the Object List to deselect all objects.

4 In the Property List, click the Marking tab, and then click Mark Count. Click the
arrow and set the mark count to 1.

0

Place the part to be marked under the focusing lens.

6  On the toolbar, click the Mark button (Figure 2-1).

I EE R EE e
by

Figure 2-1 Mark button on the toolbar

Warning Ensure that all personnel in the area are wearing
protective eyewear. Read and follow all safety
precautions described in your Marking Head’s
Operator’s Manual before beginning laser marking.
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7  When the Synrad WinMark dialog box appears (Figure 2-2), click Start-F1.

+ Syniad WinMark

- Progr

Piece Court
Total Time

Fress [F1] to start marking  Press [ESCAPE] to pause/abort mark!

Piece %

Object %

[_[O]x]

Start - F1 hl

I
——

Mark Praview [ Fast Pravisw

Mark Log

Close

EYMNRAD)

Figure 2-2 Synrad WinMark dialog box

Note: A Fiber Link Controller Card (FLCC) must be installed in your computer and
the Hardlock must be connected to your computer’s printer port before a laser

mark can be made.
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Batch marking

If your manufacturing process produces parts in batches, trays of parts for example,
batch marking may be the most appropriate method for marking them. The following
procedure steps you through a sample batch marking session. You will create an image
to be marked then use Array properties to duplicate the object and create an array that
matches the group of parts to be marked. This procedure may not meet your particular
needs but you can modify it by specifying different parameters.

Note: The group of parts must be arranged so that the arrayed image to be marked
fits within the marking field size of the focusing lens.

1 Use the Drawing Editor to create a file with text, artwork, or an imported graphic
to be marked.

2  With the object or objects selected, set marking Velocity, Power, and Resolution
on the Marking tab.

3  In the Property List, click the Format tab, and then click Array Columns
(Figure 2-3).

4 Click the arrow to increase the number of columns.
The number of columns created should match the number of columns of parts to

be batch marked.

Special | Marking Fomat | a1 |

Object Left Pos A.7568n
Object Top Pas 1.2783n

Riaster Soan Dir Vertical

[Firap Colmns E AF
Array Rlows 1

Mark Ay Yes

Show Array Yes

Column Spacing 05000 in

Fow Spacing 05000 in

Array ngle 0 dearees

Figure 2-3 Setting number of Array Columns
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5  In the Property List, click Array Rows (Figure 2-4), and then click the arrow to

increase the number of rows.

The number of rows created should match the number of rows of parts to be batch
marked.

Special| Marking Fomat a1 |

Dbisct Left Pos 7568 In
Obisct Top Pos 12783 0n

Flaster Soan Dir Vertical

Ay Columns 3

[Bmay Flows E < ﬂ
Matk Aray Yes

Show Ariay Yes

Colurnn Spacing 0.5000in
Flow Spacing 0.5000in
Ay Anale 0 degress

Figure 2-4 Setting number of Array Rows

6  From the Objects menu, click Center on Field to center the array in the marking
field.

7 On the Format tab, adjust Column Spacing, Row Spacing, and Array Angle as
required to position the arrayed image over the batch of parts.

8  On the toolbar, click the Mark button (Figure 2-5).

| Dl==(8] F7(e| ¥ 2lelo2] =2l=]s ][]
a3

Figure 2-5 Mark button on toolbar

Warning Ensure that all personnel in the area are wearing
protective eyewear. Read and follow all safety
precautions described in your Marking Head’s
Operator’s Manual before beginning laser marking.

Synrad WinMark Pro® user’s guide 2s



operation

Marking parts

O  When the Synrad WinMark dialog box appears (Figure 2-6), click Start-F1.

! Synrad WinMark

Proar

Press [F1]to start marking  Press [ESCAPE] to pauss/abort mark!

Piece Count Fee 3
Total T | Object %

Start - F1 I\l
‘ Clase

——

Mark Preview [~ Fast Freview

Mark Lag

Figure 2-6 Synrad WinMark dialog box

Note:

26

An FLCC must be installed in your computer and the Hardlock must be
connected to your computer’s printer port before a laser mark can be made.
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When creating a mark file, your choice of font for text and your choice of file format for
imported graphic images will be the primary factors that determine the overall speed
and quality of the mark. The following sections lead you through the creation of text
and graphic files that illustrate how your choices affect marking. The last section,
Optimization, provides examples of how to optimize a mark for speed or for quality.

Note: Power settings provided in this section are based on the use of a 25 W laser;
when working through the examples, laser power levels should be adjusted
accordingly for higher or lower power marking systems.

Types of marks

There are two distinct methods used to mark objects. The first method, vector marking,
is made by moving the beam from one x-y point to another x-y point (a vector) along a
straight or curved path. This type of mark is very fast, limited only by the speed of the
galvanometers moving the beam-steering mirrors. The second method of marking,
raster marking, is accomplished by switching the beam on and off as it moves across the
image. The beam returns, is moved down one step, and then makes another pass. This
rastering continues through the length of the image. If bidirectional rastering is chosen,
marking is enabled as the beam moves both directions across the image. In addition you
can specify either a horizontal or vertical orientation for rastering. Raster marking is
slower than vector marking, but rastering can create filled objects and text or even
reproduce photographic images. Figure 2-7 illustrates both types of marking methods.

Y

Y

>
>
I
|
|
|
'
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|
|
|
|
|
|

A

Vector outline Raster fill

Figure 2-7 \ector versus raster marking
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Text

When creating text, there are two categories of fonts to choose from: (1) stroke fonts or
(2) TrueType fonts. Stroke fonts are the type of fonts typically used in CAD programs
because they are drawn (or marked) very quickly using point-to-point vectors. Several
different stroke font styles are built in to WinMark Pro.

Any TrueType font installed on your computer can also be marked. If Text Fill is set to
No, the font is marked as a vector outline; if Text Fill is Yes, the font is filled by raster-
ing the beam, effectively “coloring in” the outline.

The section below illustrates the relative marking speeds of stroke and TrueType fonts.

Mark a stroke font:

1

N

Select the Text Tool from the Tool Box, position it on the Drawing Canvas and
click the left mouse button to set an insertion point. The Text Caption Editor
dialog box appears.

In the Text Caption Editor dialog box, type: ABCDEFG123.
Click OK. ABCDEFG123 appears on the canvas within a bounding outline.

On the Format tab, set Font Type to Stroke and then in Stroke Font, select a
stroke font to mark.

Choose a Text Height that will allow the text to easily fit on the Drawing
Canvas.

Click the Marking tab (Figure 2-8) and set Velocity to 30.000 in./sec., Power to
60%, and Resolution to 600.

Special| Automation Marking | Famat| &1 |

Mark Dbject ‘s

Mark Passes 1

wiobble On o

Velocity 0000 in/sec
Fower %
Resolution 0

Fline Start Delay 00 usecs
Fline End Delay 450 usecs
nterseg Delay 50 usecs

Qff Vector Delay 0 usecs

Bi Directional Raster o

Interseg Break Angle degiees

Qff Yector Velacity 75,0000 in/sec
Qff Yector Resolution 300

Spot Marking Style Mo

Spot Mark Duration 1

Figure 2-8 Marking tab object properties

2s
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Position a sheet of anodized aluminum under the lens, ensure all personnel are
wearing safety glasses, and then click the Mark button.

When the Synrad Marking Progress dialog box appears, click Start-F1.

Observe how the marking head is producing the mark. After completion of the
mark, note the cycle time.

1O Save the file as “stroke demo”.

Mark an unfilled TrueType font:

1
2

W

0

8
1S

Open a new drawing.

Select the Text Tool, position it on the Drawing Canvas and click the left mouse
button to set an insertion point.

In the Text Caption Editor, type: ABCDEFG123.

On the Format tab, set Font Type to TrueType and then in TrueType Font, select
a font to mark. Set Text Filled to No.

Set Text Height to the same value used in the stroke font example.

Click the Marking tab and set Velocity to 30.000 in./sec., Power to 60%, and
Resolution to 600.

Position a sheet of anodized aluminum under the lens, ensure all personnel are
wearing safety glasses, and then click the Mark button.

When the Synrad Marking Progress dialog box appears, click Start-F1.

Observe how the marking head is producing the mark. After completion of the
mark, note the cycle time.

1O Save the file as “unfilled TrueType demo”.

Mark a filled TrueType font:

1

2
3
4

Open a new drawing.
Select the Text Tool and click to set an insertion point.
In the Text Caption Editor, type: ABCDEFG123.

On the Format tab, set Font Type to TrueType and then in TrueType Font select
the same font used in the unfilled font example above.
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5 Set Text Filled to Yes and set Text Height to the same value used in the stroke and
unfilled font examples.

6  Click the Marking tab and set Velocity to 30.000 in./sec., Power to 60%, and
Resolution to 600.

w

Position a sheet of anodized aluminum under the lens, then mark the text.

8  Again, observe how the marking head is producing the mark and note the cycle
time.

O  Save the file as “filled TrueType demo”.

The three text examples just demonstrated show the importance of choosing fonts to
match the marking application. In processes where speed is an issue such as in marking
part numbers, date codes, or other identifying information at high throughput speeds,
stroke (vector) fonts can mark 1.5 times faster than unfilled (vector) TrueType fonts
and 10 times faster than filled (raster) TrueType fonts. When using filled TrueType
fonts to mark products that are highly visible or that must convey a quality “look” or
match a corporate logotype, longer cycle times are inevitable.

Graphics

When creating graphics, there are two basic types of file formats: (1) bitmap or (2)
vector graphics. Bitmap (raster files) such as TIFF, BMP, and JPEG are the types of files
created by paint programs (EPS and PDF files can also contain bitmap information).
Bitmap file elements are marked using the raster scanning technique. Most CAD and
illustration programs generate vector file formats such as EPS, DXF, and PDF. Vector
file elements are marked quickly using point-to-point vector movements.

Mark a bitmap graphics file:

1 Open a new drawing and then click the File Import Tool. The Open dialog box
appears, asking you to locate a file for import. For illustration purposes, we will
import a sample file included with WinMark Pro.

Note: Remember to first load the File Import Filters from disk or download and
install them from the WinMark Pro web site.

2  In the WinMark folder, double-click the Samples folder.
3 In the Samples folder, double-click the SampleImports folder.
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In the Files of type drop-down list, select (*.tif) Tagged Image File Format.

Select the Family.tif file and click Open. The bitmap file shown in Figure 2-9.

50 o7 oo o7 EET E
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|

Figure 2-9 Family.tif
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Click on the family image to select it, then use the Object Transformations dialog
box to scale the image to fit the Drawing Canvas.

Click the Marking tab and set Velocity to 15.000 in./sec., Power to 60%, and
Resolution to 600.

Position a sheet of anodized aluminum under the lens, ensure all personnel are
wearing safety glasses, and then click the Mark button.

When the Synrad Marking Progress dialog box appears, click Start-F1.

Observe how the marking head is producing the mark. After completion of the
mark, note the cycle time.

Save the file as “bitmap demo”.

Mark a vector graphics file:

1

2
3

Open a new drawing and then click the File Import Tool. The Open dialog box
appears, asking you to locate a file for import. For illustration purposes, we will
import a sample file included with WinMark Pro.

In the WinMark folder, double-click the Samples folder.
In the Samples folder, double-click the SampleImports folder.
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4 In the Files of type drop-down list, select (*.dxf) AutoCAD Drawing Interchange.

5  Select the Columbia.dxf file and click Open. The Columbia file (Figure 2-10) is a
vector graphic portraying the space shuttle as a cut-away line drawing.

e b et

Figure 2-10 Columbia.dxf

6  Click on the Columbia image to select it.

7  Click the Marking tab and set Velocity to 15.000 in./sec., Power to 60%, and
Resolution to 600.

8  Position a sheet of anodized aluminum under the lens, then mark the drawing.

O  Observe how the marking head is producing the mark. After completion of the
mark, note the cycle time.

1O Save the file as “vector demo”.

Vector graphics are used for marking objects at high throughput speeds when cycle
times are important. Bitmap graphics are appropriate when a filled logo or photographic
image is being marked and quality is the most important marking factor. You can
import both vector and bitmap files into the same drawing to lower cycle times and
obtain the best quality mark possible.

Bar codes
1 Open a new drawing.
2  Select the Bar Code Tool and click to set an insertion point.

3  On the Format tab, in the Barcode Number field, type: 123456.
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4 On the Format tab, set Barcode Style to Code 3 of 9 - 4, Barcode Resolution
to 200, and Barcode Show Text to No.

5 If marking a dark material, set Barcode Inverted to Yes.

Most bar codes are marked, or printed, dark on a light background because the
bar code must create a sharp color contrast against the material’s background for
the bar code to be machine-readable. When making a contrasting mark on dark
material, setting Barcode Inverted to Yes causes WinMark to mark the spaces
between the bars so that a contrasting space between dark bars is created.

6  Click the Marking tab and set Velocity to 15.000 in./sec., Power to 60%, and
Resolution to 600.

7 Position a sheet of anodized aluminum under the lens, then mark the bar code.

When marking plastics or ink-coated surfaces, start with Barcode Resolution settings
in the range of 200-250. Bar codes on mild and stainless steels mark best at resolutions
around 600—650. To decrease marking time, bar code resolution should not be set much
higher than the lowest resolution that provides consistently readable results.

2D Data Matrix codes
1 Open a new drawing.
2  Select the 2D Data Matrix Code Tool and click to set an insertion point.

3  On the Format tab, in the 2D Barcode Text field, click the ellipsis (...). The Text
Caption Editor dialog box appears.

4 In the Text Caption Editor dialog box, type: ABCDEFG123 and click OK.
Note: A 2D Data Matrix code can hold up to 500 characters.

5 Set Barcode Inverted to Yes if marking a dark material.

6  Click the Marking tab and set Velocity to 15.000 in./sec., Power to 60%, and
Resolution to 600.

7 DPosition a sheet of anodized aluminum under the lens, then mark the code.

For best results when marking 2D bar codes, start with Resolution settings in the range
of 600-750. Use higher resolutions when marking low contrast materials to ensure all
information is properly read.
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Markingparameters

Once a decision has been made to use a stroke or TrueType font or to use a bitmap or
vector graphic, the three most important object properties are: (1) velocity, (2) power,
and (3) resolution. These three parameters plus object delays on the Marking tab are the
primary factors that determine the speed and quality of the mark.

Velocity

Marking velocity (mirror galvanometer speed) determines how fast each microvector
is marked. Setting galvanometer velocity too high affects mark quality because delay
settings become much more critical as velocity increases. Velocity also affects power

since a faster moving beam has less heat effect on the material. Velocity is adjustable
between a range of 0.01 to 240 in./sec. (0.25 mm/sec. to 6,096 mm/sec.).

Power

Laser output power must be optimized for the material being processed and for the type
of resulting mark required. Power can be set from 0 to 100% of the laser’s actual power
output. Typically 70 to 80% will equal the laser’s specified output power in watts.
Applying too much power may engrave too deeply or char the material unacceptably.
When marking certain plastics, contrasting marks can be achieved by using very low
power settings (1 to 2 watts).

Resolution

Resolution, actually microvectors per inch, is the primary factor in mark speed and
mark quality. Increasing resolution increases cycle times but also increases the quality,
or “crispness” of the image. Reducing resolution shortens cycle times. Practical
resolution settings range from 200 for bar codes to 1000 for high-resolution graphics
or filled text.

Delays

[t is sometimes possible for the Marking Head’s galvanometer hardware to lag slightly
behind software commands while marking. To compensate, WinMark Pro provides
object-specific delays. Object delays for specific objects are set by selecting the object or
objects in an open drawing file and then setting appropriate delays on the Marking tab.
See Marking tab object properties under WinMark commands in the “Technical Reference”
section for further information.
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Optimization

Optimize a stroke font for speed

The first step in creating a high-speed mark starts with the computer hardware, since
a computer running at a faster clock speed will mark faster than one running at a
slower speed. After optimizing computer hardware, software optimization is next.
This involves determining acceptable trade-offs in WinMark Pro’s Velocity, Power,
and Resolution settings for a given drawing. These settings along with object delays
are best determined by experimentation.

Because the fastest mark possible is sometimes not legible enough to be practical, an
acceptable high-speed mark is determined by each individual application. The example
below suggests one approach you might take to adjust WinMark settings for speed:

1 Open the stroke demo.mkh file created earlier.

N

Click on the text to select it.

3  Click the Marking tab, increase Velocity from 30.000 to 60.000 in./sec. and
increase Power from 60% to 75%.

4 Position a sheet of anodized aluminum under the lens, ensure personnel are
wearing safety glasses, and then make the mark.

5  Compare mark quality and cycle time to the initial stroke font mark.

If mark quality is unacceptable after increasing Velocity, try modifying object delays
first since delays have less effect on marking speed. If mark quality still suffers after
optimizing object delays, try decreasing both Velocity and Resolution. Remember to
experiment with only one parameter at a time while comparing results. Open the
vector demo.mkh graphic file, make similar changes and compare those mark results
to the original marks.
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Optimize a filled Truelype font for quality

The level of quality acceptable for a mark is again a subjective issue. The highest
quality mark possible is often not fast enough from a production standpoint. As with
speed, creating a quality mark involves trade-offs in velocity, power, resolution, and
delay settings and again is best determined by experimentation.

The following example suggests one approach you might take to adjust WinMark Pro
settings to obtain the best quality mark:

1 Open the filled TrueType demo.mkh file created earlier.

2  Select the text.

3 Click the Marking tab and decrease Velocity to 15.000 in./sec., Power to 60%,
and increase Resolution to 1000.

4 Click the Format tab and increase Text Curve Detail to 1000 (the same as the
resolution), and set Extra Char Spacing to 0.015 in.

5 DPosition a sheet of anodized aluminum under the lens, then make the mark.
6  Compare mark quality and cycle time to the initial filled TrueType font mark.

If mark time is too slow, try reducing Resolution and Text Curve Detail together or

try increasing Velocity. Experiment with changing only one parameter at a time while
comparing results. Open the bitmap demo.mkh graphic file, and make similar changes to
Velocity, Power, and Resolution. Compare those mark results to the original bitmap
marks.
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Wiring connections between parts handling equipment and the marking system are
made so they connect to specific I/O bits on the Marking Head or Fiber Link Controller
Card (FLCC). The following example assumes that an input signal from parts handling
equipment is connected to Input Bit 0, and that an output signal to parts handling
equipment is connected to Output Bit 4. Although applications for WinMark Pro vary
widely, the following example describes a typical marking operation.

Planning the event sequence

The state diagram below, Figure 2-11, shows the sequence of events that are necessary
for coordinating parts handling and marking. Each event is designated with a number
that is referenced in the following procedure.

Events
12 3 4
Set-1__
Input Bit O part is in staging partisin staging
Input from handler position part position part
Set-0___|
Set-1__:
Output Bit 4 laser laser
Output to handler laser on ready laser on ready
Set-0_
begin marking begin marking
marking complete marking  complete

Figure 2-11 Sample state diagram

Event 0 — (not shown on the State Diagram) occurs before a part enters the system.

Event 1 — begins the sequence when a logic 1 value is received from the parts
handling equipment, signaling that the next part to be marked is in
position. This input triggers Input Bit 0, which will turn the laser on
when all other conditions are met.

Event 2 - informs parts handling equipment that lasing is in progress. This event
occurs almost immediately after receiving Event 1.

Event 3 — is an output to the parts handling equipment signaling that the laser is off
and that another part can be staged. This event occurs during the period of
time that the parts handling equipment has allowed for parts marking.

Event 4 — is a signal from the parts handling equipment indicating that a new part is
being staged.
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Iimplementing the plan

Event O

1 Select Drawing from the Object List.

2  Select the Automation tab on the Property List.

3 Select Set Digital Before Piece and click the down arrow.

Set Digital Before Piece sets the digital state of the output prior to executing
planned Event 1.

4 Click on Bit 4, click the down arrow, and then select Set from the drop-down list
(Figure 2-12).

Selecting Set assigns a logic 1 value to Output Bit 4. This output signals the parts
handling equipment that the laser is off and is ready for a new part to be staged.

Automation | Marking | Format | &1 |

O Before Mark Session | Undefined
52t Digital B fore Piecs
\w/ait Digital Eefore Pisce | [Bit 1 ‘ gnore

On Before Mark Piece | Bt 3 lanars
Set Digital Befors Mark | [Bit4 ae
\wait Digital After Piece
On After Mark Piece
Set Digital After Mark
On After Mark Session | Undefined

Figure 2-12 Setting “Set Digital Before Piece”
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Event 1
1 Select Wait Digital Before Piece.

Wait Digital Before Piece waits for the designated logic state to occur at the
input. When this state is met, plan execution will continue.

2  Click Bit 0, then select Set from the drop-down list (Figure 2-13).

Selecting Set assigns a logic 1 value as the anticipated logic state on Input Bit O.
When this state is matched, plan execution will continue. In this example, parts
handling equipment sets Bit O once a new part is in position to be marked.

Automation | Marking | Format | &1 |

On Before Mark Session | Event Defined
Set Digital Before Piecs
/it Digita] Before Piece
On Before Mark Piece
Set Digital Before Mark
\wait Digital After Piece

On After Mark Piece ignore
Set Digital After Mark Bit 4 lgnore
[ After Mark Sassion B} lircie
Bit6 gnore
Bit 7 anore

Figure 2-13 Setting “Wait Digital Before Piece”
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Event 2
1 Select Set Digital Before Mark.

Set Digital Before Mark sets the designated logic state at the output immediately
prior to marking.

2  Click Bit 4 then select Clear from the drop-down list (Figure 2-14).

Selecting Clear assigns a logic 0 value to Output Bit 4. The digital state set here
is an output, signaling parts handling equipment that the laser is on and marking.

Automation | Marking | Format | &1 |

On Before Mark Session | Undefined
Set Digital Before Pisce | 1

\w/ait Digital Bsfors Plecs | 1---

On Before Mark Piece | Undsfined
52t Digital B for Mark
\w/ait Digital After Piecs | [Bit 1
On After Mark Piece Bit3
Set Digital After Mark Bit 4
On After Mark Session | B3

Figure 2-14 Clearing “Set Digital Before Mark”
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Event 3
1 Select Set Digital After Mark.

Set Digital After Mark sets the designated logic state at the output immediately
after marking.

2  Click Bit 4 then select Set from the drop-down list (Figure 2-15).

Selecting Set assigns a logic 1 value to Output Bit 4. The logic 1 value set here is
an output signaling the parts handling equipment that the laser is off and is ready
for another new part to be staged.

Automation | Marking | Fomat| &1 |

On Before Mark Session | Undefined
Set Digtal Before Piece | -1

wait Digital Before Piece | 1

On Before Mark Piece | Undefined
Set Digtal Before Mark | -0

w/ait Digital Alter Pisce | -
Onlter Mark Piece | Undefined

Figure 2-15 Setting “Set Digital After Mark”
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Event 4

1 Select Wait Digital After Piece.

Wait Digital After Piece waits after marking for the designated logic state to occur
at the input. When this state is met, plan execution will continue.

2 Click Bit 0 then select Clear from the drop-down list (Figure 2-16).

Selecting Clear assigns a logic O value as the anticipated logic input state on Input
Bit 0. When this input state is matched, plan execution will continue. In this
example, parts handling equipment clears Bit O to indicate a new part is being

staged.

Automation | Marking | Format | &1 |

On Befors Mark Session

Set Digital Eefore Piscs

Undefined

\w/ait Digital Eefore Piscs

1-

On Befors Mark Piece

Undefined

Set Digital Bafore Mark

[/t Digital At Piece
On After Mark Piece

Set Digital After Mark

On After Mark Session

‘ Bit O

‘ Bit1

Btz Set
B3 lgnore
Bit 4 gnore
Bit5 lgnare
Bit6 gnore
Bit 7 Ignare

Figure 2-16 Clearing “Wait Digital After Piece”
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Automation examples

Serial marking

If your manufacturing process produces parts one at a time, serial marking may be the
most appropriate method for marking. The following procedure steps you through a
sample parts marking session. This procedure may not meet your particular needs but
you can modify it by specifying different parameters.

Note: In addition to serializing text, WinMark Pro can also serialize bar codes and
2D Data Matrix codes.

1 Select the Text Tool and click to set an insertion point.

2  Type 0000 in the Text Caption Editor dialog box and then click OK.

The number of characters entered in the Text Caption Editor dialog box should
equal the maximum number of digits you plan to serialize. In our example, the
maximum number of parts serialized would be 9999 before the counter resets.

3 Position the cursor over a blank area of the Drawing Canvas and click the left
mouse button or select Drawing on the Object List to select the drawing object.

4 Select the Marking tab from the Property List and select Ask Mark Count. Click
the down arrow and specify Yes (Figure 2-17).

Setting Ask Mark Count to Yes causes the Piece Count dialog box to appear,
which requires the operator to enter the number of pieces to be marked during
the marking session.

Automation Marking | Famat| a1 |

[Field Offset< 0000 in
Field Oifoet 0000 in

Field Rotation iees
Field Transform Org % 10000 in
Field Transform Org Y 10000 in
Field Scale X 0
Field Scale Y 003
[k Mark Count
ark Count

o Cross
nver X Axis Rl
nvert Y Awis Mo

ark File

Figure 2-17 Setting “Ask Mark Count” to yes
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5 Select the Automation tab from the Property List and select On After Mark Piece.
Clicking the ellipsis (...) causes the Event Builder dialog box to appear.

6  In the Event Builder dialog box, click Add in the Commands frame.

7 In the field labeled I in the Commands frame, click the down arrow and select
IncSerial from the drop-down list.

Adding IncSerial increments (or decrements) alphanumeric characters entered in
the text string.

8  In the Target Object and Property frame select Textl from the Object List and
TextCaption from the Property List.

The characters in the TextCaption of Textl are the elements to be serialized.

9O  Click Add in the Commands frame again and in field 2 click the down arrow
to select DoPause from the drop-down list (Figure 2-18). After DoPause is
selected, click Delay (msecs) in the Command Details frame to change the pause

time period.

Adding DoPause allows you to specify a wait period between marking so that
a new part can be positioned in the marking field.

Event Builder

i~ Commands
Add Inz Del

IncSeral
MarkingHeadn
MatchDigitslState
FeadFromS erialPort
ReadLineFromFils
FleadyStatus
RestorePrapert

i~ Command Detail;

Delay [msess)

[ 1000

Object

~ Target Object and Prapet

Property

Mot used

Mot used

DoPause

Pauses fior a specified number of milliseconds.

Carcel

Figure 2-18 Selecting “DoPause” in the Event Builder dialog box
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1O Click OK to close the Event Builder dialog box.

1 1 Click the Mark button in the Shortcut bar and then click Start-F1 when the
Synrad WinMark dialog box appears.

Warning Ensure that all personnel in the area are wearing
protective eyewear. Read and follow all safety
precautions described in your Marking Head’s
Operator’s Manual before beginning laser marking.

12 When the Piece Count dialog box appears (Figure 2-19), enter the number of
pieces to be marked.

If O is entered in the Piece Count dialog box, unlimited marking occurs until the
ESC key is pressed to end the mark session.

Please enter the number of pieces to be K
matked, or enter ‘0 for unlimited marking [ESC _
an be used to abort mark) e

E %

Figure 2-19 Piece Count dialog box

13 Ensure that all personnel in the area are wearing protective eyewear before
clicking OK to start laser marking.

Note: The Hardlock must be installed on your computer’s printer port before a laser
mark can be made.

The next chapter, “Technical Reference”, contains four sections. WinMark Pro
commands describes the commands available through WinMark Pro’s Drawing Editor.
WinMark Pro object properties explains object properties and how they are used to
control marking. Event Builder commands discusses the commands used to integrate
laser marking with automated parts handling equipment. ActiveMark technology
describes WinMark Pro’s implementation of ActiveX control.
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Use information in this section as a reference to WinMark Pro’s powerful
command and automation controls.

This section contains the following information:

WinMark Pro commands — explains the commands available from

WinMark Pro’s menu bar.

WinMark Pro object properties — describes drawing object properties
and how they control object display, automation, and marking.

Event Builder commands — describes how these predefined commands
provide automation functions during the marking process.

ActiveMark technology — describes WinMark Pro’s implementation
of ActiveX control.
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Commands are available and can be used if they are displayed as normal type on drop-
down lists. Commands that appear dimmed are not available until an object selection
affecting them is made.

File

File commands (Figure 3-1) perform common file functions such as opening, saving,
and printing. In addition, specific functions such as importing graphics files and starting
laser marking can be accomplished from WinMark Pro’s File menu.

Hew Cul+N
Open Cul0
Save Culs5
Save bs

Print &1l Propeties
Fiint Diawing..

Impart...

Hark.. CulM
uick Mark Fl

1 Untitled1. mkh
2 Uniitled3.mkh
3Luggage mkh
4 C:\Program Files?...\body FH7

Exit

Figure 3-1 File menu

New - open a new, untitled drawing window.

Open... — open the Open dialog box. Navigate through your system to find and open
existing .mkh mark files.

Save - save changes made to the currently active drawing. When saving an untitled
drawing, the Save As dialog box appears and prompts you to enter a filename.

Save As... —display the Save As dialog box, which prompts you to save the currently
active drawing as a .mkh drawing with a new filename or path.

Print All Properties... — print object properties for all objects contained in the
active drawing. Use the Print dialog box to specify a printer or printer properties.

Print Drawing... — print the active drawing. Use the Print dialog box to specify a
printer or printer properties.

Import... — imports a graphics file for placement in the currently active drawing.
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WinMark Pro commands

Note: Any text or filled objects contained within a graphic file will not be imported
with the graphic. Filled text can be imported by first converting the text into
vector or bitmap artwork. Consult your illustration program’s User’s Manual
for instructions.

Supported file formats include:

.ai—  Adobe [llustrator (v4.0) Format .igs — IGES Drawing Format

.bmp — Windows Bitmap .jpg — JPEG File Format

.cdr — Corel DRAW! Drawing .met — OS/2 PM Metafile

.cgm — CGM Graphics Metafile .mkh — Synrad WinMark PRO Format
.ch3 — Harvard Graphics 3.0 Chart .nap — NAPLPS Standard ANSI
.cmx — Corel Presentation Exchange 5.0 .pcd — Kodak Photo-CD Format

.ctm — Clear Text CGM .pct— Macintosh PICT Format

.dib —  Microsoft Windows DIB .pcx — Zsoft PC Paintbrush Bitmap
.drw — Micrografx Drawing .pdf — Adobe Portable Document Format
.dsf —  Micrografx Designer 6.0 .pdi — NAPLPS IBM PC VideoTex
dwf - AutoDesk WHIP! Drawing Web .pic — Lotus 1-2-3 Picture File

.dwg — AutoCad Drawing (v12.0) Format .pic— NAPLPS General Parametrics

.dxf — AutoCad Drawing (v12.0) Interchange .pif — IBM Picture Interchange

.emf — Enhanced Windows Metafile .plt = HP Graphics Language

.eps — Encapsulated PostScript File .png — Gif24 / PNG File Format
fmv — Frame Vector Metafile .ps —  PostScript Language Format
.gdf —  Graphics Data Format .rnd — AutoShade Rendering

.gem — Digital Research GEM Format .sy3 — Harvard Graphics 3.0 Symbol
.gif —  Graphics Interchange Format .tif —  Tagged-Image File Format
.hgl = HP Graphics Language .wmf — Microsoft Windows Metafile
.hpg — HP Graphics Language .wpg — WordPerfect Graphic File

Click Import to open the Open dialog box. Navigate through your system to find and
open importable files by filename or specific graphics file extension.
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Mark... — initiate and preview marking of the currently active drawing through the
Synrad WinMark dialog box. The dialog box also provides piece count and total elapsed
time in addition to a mark log displaying real-time marking status.

Quick Mark — initiate immediate laser marking without prompting the user. Pressing the
F1 function key also begins Quick Mark marking of the current drawing.

“recent file” — display the four most recently opened files. Click a filename to open as
the current drawing.

EXit — close the WinMark Pro application; a dialog box prompts you to save any
unsaved changes. Click the Cancel button to cancel the exit request.
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Edit

Edit commands (Figure 3-2) perform common functions such as copying, pasting, and
selecting. An object inserted into a drawing using Paste or Duplicate retains all the
properties of the original object, however those properties can be edited individually as
required.

Unda Chil+2
Bedo Chil+'
Cut Chrl+
LCopy Chil+C
Paste Chil+f
Delete [rel
Dwuplicate Chil+D
Select All

Figure 3-2 Edit menu

UNdo — undo the last action. The number of undo levels is determined by WinMark
Pro’s Undo Depth setting. Your computer’s memory capacity may also affect the
maximum number of undo levels available.

Redo - redo the previously undone action.

Cut - cut the selection and save to the Clipboard. Only the last selection cut or copied
to the Clipboard is available for use.

Copy - copy the selection to the Clipboard. Only the last selection cut or copied to
the Clipboard is available for use.

Paste - paste the current Clipboard contents into the drawing.
Delete — delete the selection without saving to the Clipboard.
Duplicate - duplicate the selection and place into the drawing.

Select All — select all objects in the currently active drawing.
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Objects

Objects commands (Figure 3-3) perform common functions such as grouping, aligning,
and transforming.

Group
W haroupE

Align... Chrl-2
Center on Field Chl-F

Transformations. .. Chl-T
irror 3
Set Marking Order...

Use Object For Defaults...

Figure 3-3 Objects menu

Group — group selected objects into a single object. Once grouped, some individual
object properties are not displayed; only group properties are displayed and editable.

Ungroup — ungroup a grouped object into its individual component objects. Un-
grouped objects display all their previously defined properties.

Align... —align two or more selected objects horizontally or vertically. Horizontal
alignments are made from the objects’ left, right, or horizontal centerlines. Vertical
alignments are made from the objects’ top, bottom, or vertical centerlines.

Center on Field - center the selection on the 0, 0 point of the Origin Lines.
Transformations... — resize, scale, rotate, or move the selection.

Mirror — Flip, or mirror, the selection horizontally or vertically.

Set Marking Order... — select the order in which objects on the Drawing Canvas
are marked. The Configure Marking Order dialog box displays all objects on the current

drawing allowing you to move objects up or down in the marking order.

Use Object For Defaults... —set all properties of the selected object as the default

for all new objects created in this or future drawings.
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View

View commands (Figure 3-4) perform common functions such as zooming in or out of
the Drawing Canvas, or showing/hiding window elements.

Zoom Extents
Zoom Page
Zoom |n
Zoom Out

v Main Bar
v Draw Tools
v Statuz Bar
v Properties
wiork Book

Figure 3-4 View menu

Zoom Extents — maximize the display of all objects on the Drawing Canvas.
Zoom Page - display the entire Drawing Canvas.

Z00m IN = zoom in towards the center of the Drawing Canvas by a factor of two.
Zoom Out - zoom out from the center of the Drawing Canvas by a factor of two.
Main Bar - toggle the check mark to show/hide the Main (toolbar) Bar.

Draw Tools — toggle the check mark to show/hide the Tool Box.

Status Bar - toggle the check mark to show/hide the Status Bar.

Properties - toggle the check mark to show/hide the Properties window.

Work Book — toggle the check mark to show/hide Work Book tabs. Each tab contains
a separate currently open drawing.
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Tools

Tools commands (Figure 3-5) perform functions such as customizing global settings and
defaults.

General Settings...
Startup Optiong...
Wirtual Lazer Marking...

winbd ark Active Control Help

Figure 3-5 Tools menu

General Settings... Application Settings tab - control global properties of
WinMark Pro software (Figure 3-6).

Important Note: Application settings do not transfer with a mark file copied to
another computer running WinMark Pro software. Transferring a
drawing to a faster or slower computer may require adjustment of
some application settings or marking properties such as delays.

Application Setings | Drawing Defaults | Object Defauls |
’Apphcalmn settings are the global properties of the appiication. Modify these properties
tos modiy different aspects of the behavior of Wirba
Lens Fenix 200 mm S
uncher Madfy Password winmark
ow Units Type Inches
ow Comman Praps Al Props
ow Grid Yes
ow Origin Yes
i Offset % 0.0000 in
i Offset Y 0.0000 in
tid Spacing 01000 in L
nan To Grid Yes
Nudge S pacing 01000 in
Show Top Fuler Yes
Show Left Auer Yes =l
I
s |

Figure 3-6 Application Settings tab

Lens

Select a lens corresponding to the currently installed focusing lens for your marking
system. Click Lens and then click the ellipsis (...) to view the Lens Selection dialog box.

Note: When using the FH Head, select a lens from the Fenix lens group.
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Launcher Modify Password

Create a password to enable drawing modifications within the WinMark Launcher
application. The default password is winmark.

Show Units Type

Select inches, millimeters, or centimeters as the display unit for all measurements.

Show Common Props

Display all properties or only common properties when multiple objects are selected on
the Drawing Canvas.

Show Grid
Toggle display of the Drawing Canvas grid on or off.

Show Origin

Toggle display of the Drawing Canvas XY origin lines on or off.

Grid Offset X

Offset the drawing grid in the X direction by a specified amount.

Grid Offset Y

Offset the drawing grid in the Y direction by a specified amount.

Grid Spacing

Change spacing between drawing grid lines.

Snap To Grid

Toggle on to restrict object placements, translations, or scaling to grid line
intersections.
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Nudge Spacing

Specify the distance that selected objects are moved with the arrow keys. If Snap to
Grid is On, the distance moved is equal to the Grid Spacing.

Show Top Ruler
Toggle display of the upper drawing ruler on or off.

Show Left Ruler
Toggle display of the left drawing ruler on or off.

Invert X Axis

Invert all marking output along the horizontal (X) axis.

Invert Y Axis

Invert all marking output along the vertical (Y) axis.

DA Card Address

Set the decimal Fiber Link Controller Card (FLCC) address. This number must match
the hexadecimal address set by the DIP switches on the FLCC. WinMark Pro’s default
address is 816 (the FLCC’s default hexadecimal address of 330 equals decimal 816).

Disable Marking

Toggle to disable/enable all marking output.

Undo Depth

Set the number of undo levels in WinMark. Computer memory capacity may affect the
maximum number of undo levels.

Fenix Keyboard Locked

Lock all membrane keyboard functions (except for the Emergency Off pushbutton) on
Fenix marking systems.
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General Settings... Drawing Defaults tab - set default properties for all new
drawings created. Property descriptions can be found in the Format tab and Marking tab
sections.

General Settings... Object Defaults tab - set default properties for all new
objects you create in current or new drawings. Property descriptions can be found in the
Format tab and Marking tab sections.

Startup Options... —set WinMark to load a specific drawing when started, start
marking immediately after loading, or start WinMark Launcher automatically on
computer startup.

Virtual Laser Marking... — overlay a high-resolution scanned image of the part to
be marked on the current drawing. Use this feature to precisely align the drawing to
your part.

WinMark ActiveX Control Help — open a Help window describing how to use
WinMark’s ActiveX control.

Note: WinMark ActiveX control is not available in WinMark Lite.
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Window

Window commands (Figure 3-7) allow you to perform functions such as switching
between or arranging multiple drawing windows.

LCazcade
Tile

v 1 Untitled1

Figure 3-7 Window menu

Cascade - overlap all open drawing windows.
Tile — arrange all open drawing windows side-by-side.

“current active file” — select any open drawing as the currently active drawing.

Help

Help commands (Figure 3-8) display program information.

Ahout Spnrad Winkdark. .

Autornation Flawchart. ..

Figure 3-8 Help menu

About Synrad WinMark... — display current version number as well as program,
copyright, and support information.

Click the Head Info button to see Marking Head information such as type, head type,
data transfer size, lens type, and firmware version.

Automation Flowchart... — display a flowchart indicating the proper order of
events when using WinMark Pro automation features.
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All objects created or imported on the Drawing Canvas have sets of properties associ-
ated with them. These properties allow you to define how each specific object is
displayed or marked. Select an object on the Drawing Canvas or highlight an object
name in the Object List to review or modify its properties. In addition to objects you
place on the Drawing Canvas, the drawing object itself (the .mkh marking file)
contains properties that allow you to apply global changes to marking output, or
communicate with automated parts handling equipment. Click on Drawing in the
Object List to select the drawing object.

Object properties are classified by category in the Property List and include Automa-
tion, Marking, Format, Special, and All tabs. Click on the All tab to display all properties
for the selected object.

Automation tab

Automation tab drawing events

Automation drawing events (Figure 3-9) occur at various stages during the marking
process. Certain events allow you to assign predefined Event Builder commands to
perform automation functions while other events exert input/output (I/O) control
through Marking Head or FLCC input and output bits. WinMark Pro is able to read
and respond to the status of individual input bits or write set/clear commands to
individual output bits. These events establish interface protocols between WinMark
Pro and your parts handling equipment and are specific to each individual drawing.

Automalion | Marking | Famat| &1 |

On Before Mark Session | Undefined
Set Digital Before Fiece | -

'wait Digital Before Fiece | -

On Before Mark Piece | Undefined
Set Digital Before Mark | -

wait Digital &fter Piece | -

On After Mark Fiece Undefined
Set Digital After Mark
On After Mark Session | Undefined

Figure 3-9 Automation tab drawing events
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On Before Mark Session

Define events you wish to trigger only once prior to the start of all parts marking in the
current marking session. Click the ellipsis (...) to open the Event Builder dialog box for
a list of definable events. See Event Builder commands later in this section for a list of
available commands.

Set Digital Before Piece

Set a specific digital state on any or all output bits prior to each piece being marked.
For example, your parts handling equipment may require a specific output bit be set or
cleared indicating the laser is off before staging a new part.

Wait Digital Before Piece

Set a specific digital state to be read on each input bit before program execution will
continue. For example, your parts handling equipment may set or clear a specific input
bit to indicate a new part has been properly positioned.

On Before Mark Piece

Define events you wish to trigger once before each piece is marked. Click the ellipsis
(...) to open the Event Builder dialog box for a list of definable events. See Event
Builder commands later in this section for a list of available commands.

Set Digital Before Mark

Set a specific digital state on each output bit immediately before each piece is marked.
For example, your parts handling equipment may require a specific output bit be set or
cleared indicating the laser is on and marking.

Wait Digital After Piece

Set a specific digital state to be read on each input bit before program execution will
continue. For example, your parts handling equipment may set or clear a specific input
bit to indicate a new part is being positioned.

S1a Synrad WinMark Pro® user’s guide



technical reference

WinMark Pro object properties

On After Mark Piece

Define events you wish to trigger once after each piece is marked. Click the ellipsis (...)
to open the Event Builder dialog box for a list of definable events. See Event Builder
commands later in this section for a list of available commands.

Set Digital After Mark

Set a specific digital state on each output bit immediately after each piece is marked.
For example, your parts handling equipment may require a specific output bit be set or
cleared indicating the laser is off before a new part can begin to be staged.

On After Mark Session

Define events you wish to trigger only once after all marking in the current session is
complete. Click the ellipsis (...) to open the Event Builder dialog box for a list of
definable events. See Event Builder commands later in this section for a list of available
commands.

Automation tab object properties

Automation object properties (Figure 3-10) apply to objects contained within the
drawing. Some properties are common to most objects while other properties apply only
to specific types of objects. Properties described below help automate the serialization
or coding of parts.

Special Automation | Marking]| Famat| &1 |

Auto Text Type

Serial Number Text

Execute Auto Text When

Before Mark

Auto Text Within Array

es

Serial Number Delta

Serial Mumber Mask

535

Serial Piece Step

Hexadecimal Count

Mo

sk Starting Serial

‘fes

Save Last Serial

‘fes

Save Serial Name

Slhot-00

Current Saved Yalue

text

Synrad WinMark Pro® user’s guide

Figure 3-10 Automation tab object properties

315



technical reference

WinMark Pro object properties

Auto Text Type

Select the type of automated text input from sources such as serial numbering, date
coding, or text from user entry, a disk file, or serial port. If using serial port input, set
your communications port handshake parameters to : 9600 baud, 8 bits, 1 stop bit, No
parity, and Flow Control.

Execute Auto Text When

Set the serialization action to occur either before or after the piece is marked.

Auto Text Within Array

Enables the selected serialization action within any array elements you have created.

Serial Number Delta

Set a positive or negative value by which the serial number increments or decrements
each time.

Serial Number Mask

Control which serial number characters are held fixed and which characters are
incremented or decremented. From the drop-down list, select a placeholder position
and then choose Serialize or Fixed.

Serial Piece Step

Specify the number of pieces to mark before changing the serial number.

Hexadecimal Count

When set to Yes, WinMark Pro increments and marks serial numbers using the hexa-
decimal (base 16) number system.

Ask Starting Serial

When set to Yes, a dialog box prompts the operator to enter the starting serial number
at the beginning of each marking session.
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Save Last Serial

Restore the last serial number marked when the next marking session begins.

Save Serial Name

Create a unique name for storing the “Save Last Serial” number. The actual number is

stored in the computer’s System Registry and so is not accessible by programs other
than WinMark Pro.

Current Saved Value
Contains the current “Save Last Serial” number value.

Assign Date Format

Click the ellipsis (...) to select or define specific date code formats. The Date Format
Customization dialog box allows you to select from among American Standard, Euro-
pean Standard, Week-Year, or Julian formats or create up to ten different custom
formats. When coding by shift, the Define Shifts button allows you to customize shift
start and shift end hours.

To create a custom date format:

1 In the Date Format Customization dialog box select and click a custom Format
Name (0-9).

2  If desired, type a descriptive name in the Format Name box.
3 Browse the Awailable Format Commands box for available date or time formats.

4 Type the format command for the desired date or time format (including the
% sign) in the Format Definition String box.

5 When done, click the Close button.

Time Offset: Day

Specify a positive or negative offset from the current day when printing expiration
dates.
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Time Offset: Hours

Specify a positive or negative offset from the current hour when printing expiration
dates or shift codes.

Time Offset: Minutes

Specify a positive or negative offset from the current minute when printing expiration
dates or shift codes.

Text Source Filename

Specify a filename containing the text source to read when using disk file text.

Auto Text File Wrap

If set to Yes, WinMark Pro reads each item in a text file and after the last item, wraps
back around to the beginning item. Use Mark Count (on the Marking tab) to specify
the number of iterations through the file. Because one line of text is read on each pass,
each line must end with a carriage return to provide the End Of Line (EOL) delimiter.

Text From Com Port

Specify which communications port contains text information to read.

Com Port Timeout

Set the communications port timeout period in milliseconds (ms). The mark will fail if
information is not available at the port within the specified time.

Text User Prompt

Create a customized dialog box prompting the operator to enter user text.
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Marking tab

Marking tab drawing properties

These properties (Figure 3-11) perform global drawing transformations such as position-
ing or scaling your drawing on the part to be marked. Drawing transformations only
affect the actual marking output; Drawing Canvas objects are not affected.

Automation Marking | Format | &1 |

Field Dffset 0.0000 in
Field Dffset 0.0000 in
Field Rotation 0 degrees
Field Transform Oig % 0.0000 in
Field Transform Oig 0.0000 in
Field $cale % 100%
Field $cale v 1

sk Mark, Count Mo
Mark Count 1

%

Mo Cross Mo
Invert 2 Axis Mo
Invert Y xis Mo

Mark File

Figure 3-11 Marking tab drawing properties

Field Offset X

Enter the amount of drawing offset required in the X-direction when marking.

Field Offset Y

Enter the amount of drawing offset required in the Y-direction when marking.

Field Rotation

Enter the amount of drawing rotation required around the transformation origin when
marking.

Field Transform Org X

Specify the transformation X-origin required when offsetting, rotating or scaling a
drawing to be marked. The default origin point is X=0.
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Field Transform Org Y

Specify the transformation Y-origin required when offsetting, rotating or scaling a
drawing to be marked. The default origin point is Y=0.

Field Scale X

Specify the percentage of X-axis scaling around the transformation origin.

Field Scale Y

Specify the percentage of Y-axis scaling around the transformation origin.

Ask Mark Count

If set to Yes, the Piece Count dialog box appears before marking begins prompting the
operator to enter the number of pieces to be marked during the marking session.

Mark Count

Specify the number of pieces to be marked during the marking session. If zero is

entered, marking will continue until terminated by the Esc key or by event automation.
Use WinMark Pro’s automation and I/O features to receive signals from parts handling
equipment that another piece has been moved into position and is ready to be marked.

No Cross

Enter Yes to prevent the beam from crossing a previous mark. Use this feature to
minimize “pits” or hot spots when lines intersect each other.

No Cross Gap

If “No Cross” is set to Yes, enter a No Cross Gap dimension.

Invert X Axis

Invert marking output along the horizontal axis.
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Invert Y Axis

Invert marking output along the vertical axis.

Mark File

Shows the path and filename of the .mkh mark file specified as the current startup file.

Marking tab object properties

These properties (Figure 3-12) apply to objects contained within the drawing and
specify how a particular object will be laser marked. Most properties are common to all
objects but some properties apply only to specific types of objects.

Special | Automation Marking | Fomat | Al |

Mark Obiect Yes -
Mark Passes 1

w/nbhle On

Tes

w/ohble Thickness

0.0200 in

\wabble Step Size

0.0100 in

Velocity

15,0000 infsec

Povier

50%

Resolution

300

Pline Start Delay

100 usecs

Pline End Delay

450 usecs

Interseg Delay

350 usecs

Off Wector Delay

300 usecs

Bi Directional Raster

Mo

Interseg Break Angle

30 dearees

Off Yector Yelacity

75,0000 infsec

Off Vector Resolution

300

Figure 3-12 Marking tab object properties

Mark Object

Toggle (yes/no) whether or not to mark the selected object.

Mark Passes

Specify the number of passes required to mark the selected object.

Wobble commands

The Wobble commands described below allow you to create thick lines or strokes when
marking objects by “wobbling” the laser beam back and forth. Although “Wobble”
provides the ability to create wide strokes, there is a significant increase in cycle time.
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Wobble On (polyline, text, and circle objects only)
Toggle (yes/no) to mark thick line strokes by “wobbling” the laser beam.

Wobble Thickness (polyline, text, and circle objects only)
Specify the “Wobble” width of object segments.

Wobble Step Size (polyline, text, and circle objects only)

Enter a specific distance between “Wobble” steps.

Velocity

Specify a galvanometer velocity when marking the selected object.

Power

Enter the percentage of laser power required to mark the selected object. A value of
70-75% usually equals the laser’s specified power rating.

Resolution

Enter the required microvector marking resolution of the selected object in dots per
inch (DPI).
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Delay commands

Because galvanometers require a finite amount of time to overcome mirror inertia and
then move the mirror into position, it’s possible for the galvanometer hardware to lag
slightly behind the software commands. Delay commands “fine tune” the marking of
each object in your drawing file. If delay related marking problems occur, first start
with all Marking tab delays set to their default values (see below). Next review the
descriptions for Pline Start Delay, Pline End Delay, Interseg Delay, and Off Vector
Delay and then make adjustments to the appropriate delays, ensuring that only one
delay is adjusted at a time in order to avoid confusion and obtain the best trade-off
between marking quality and marking speed.

To check marking delays, perform the following steps:

1 Select an object or objects on the Drawing Canvas.
2  In the Property List, click the Marking tab.

3 Scroll down to the delay section shown in Figure 3-13.

Special Mtking | Fomat | &1 |

Mark Obiect

Tes

ark Passes

1

w/nbhle On

Mo

Velocity

15,0000 infsec

Povier

50%

Resolution

300

Pline Start Delay

100 usecs

Pline End Delay

450 usecs

Interseg Delay

350 usecs

Off Wector Delay

300 usecs

Interseg Break Angle

30 dearees

Off Yector Yelacity

75,0000 infsec

Off Vector Resolution

300

Spot Marking Style Mo
Spot Mark Duration 1

Figure 3-13 Delay settings

4 Check that the following initial parameters are set:

Pline Start Delay 100 ps
Pline End Delay 450 ps
Interseg Delay 350 ps
Off Vector Delay 300 ps
Off Vector Velocity 1905 mm/sec (75.00 in./sec)
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Pline Start Delay

Use Pline Start Delay to minimize hot spots at the beginning of a polyline or the
beginning of a series of polylines. See Figure 3-14 for illustrations of Pline Start Delay
effects. Increase the delay to reduce dwell (hot spots) at the beginning of each polyline.
If too large a delay is set, the beginning of a polyline may be shortened or shapes may
not close properly. Pline Start Delay affects only the beginning of non-connected
polylines.

-« -« -«
Pline Start Delay or Pline Start Delay Correct Use of
Too Short Too Long Pline Start Delay

Figure 3-14 Pline Start Delay settings

Note: Setting the Pline Start Delay properly may not entirely eliminate hot spots
because of the laser’s natural tendency to produce a small initial spike of power
when first turned on.
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Pline End Delay

Pline End Delay maintains beam output at the end of a series of polylines to ensure that
the current polyline is completed before moving to the next polyline vector. See Figure
3-15 for illustrations of Pline End Delay effects. Too much delay will create dwell, or
hot spots, at the end of polylines; too little delay may cause short or incomplete

polylines to be marked.

Pline End Delay or Pline End Delay
Too Long Too Short

Figure 3-15 Pline End Delay settings
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Interseg Delay

Interseg Delay sets a delay between marking connected polylines where the end point
of the current polyline is the start point of the next polyline in the object. Interseg
Delay increases the “sharpness” of points where polylines connect. See Figure 3-16 for
illustrations of Interseg Delay effects. Too much delay creates dwell, or hot spots, at the
end of polylines; too little delay causes corners to be rounded.

4 )

Interseg Delay or Interseg Delay Correct Use of
Too Long Too Short Interseg Delay

Figure 3-16 Interseg Delay settings

Bi-Directional Raster

Enable bidirectional scanning which can speed up mark time when filling a raster
image.
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Off Vector Delay

Off Vector Delay sets a proportional delay during all laser off-vector moves to eliminate
“tails” when moving between non-connected polylines. See Figure 3-17 for illustrations
of Off Vector Delay effects. Too much delay will create a good mark, but marking
throughput (cycle time) may be unacceptably slowed; too little delay may cause “tails”,
leading marks at the beginning of polylines.

— — —

R — E— R —
-« -« D Sl
Off Vector Delay or Off Vector Delay Correct Use of
Too Long (Causes Too Short Off Vector Delay

Long Cycle Times)

Figure 3-17 Off Vector Delay settings
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Interseg Break Angle

Specifies a break angle between two connected polylines. No Interseg Delay is used
when the angle between the two marked polylines is less than the specified angle. If the
angle exceeds the Interseg Break Angle, then the Interseg Delay value is used. Figure
3-18 shows the results of marking two different angles using the default Interseg Break
Angle of 30 degrees.

e —_—>
~a. . O
25° angles

90° angles l

— )

Angles are less than the specified Angles are greater than the specified

Interseg Break Angle. No Interseg Interseg Break Angle. Interseg Delay is

Delay is used. used to prevent hot spots or rounded corners.

Figure 3-18 Interseg Break Angle settings

Off Vector Velocity

Set a non-marking velocity for galvanometers to travel between polyline endpoints.
Generally this number should be set close to the marking Velocity value.

Off Vector Resolution

Set a non-marking resolution in dots-per-inch (dpi) when galvanometers travel
between polyline endpoints. Generally this number should be set close to the marking

Resolution value.

Spot Marking Style

When set to Yes, the mark is made using individual spots instead of a continuous line.
Spot spacing is proportional to the Resolution setting. The Spot Marking Style is
primarily used when marking glass to prevent fracturing.
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Spot Mark Duration

Set the lasing duration for the Spot Marking Style in increments of 1/10 of a milli-
second (0.0001 sec.).

Format tab

Format tab drawing properties

These properties (Figure 3-19) allow you to specify a new field size if the focusing lens
on your Marking Head is changed. Every focusing lens provided by SYNRAD has the
field size marked on it. See Tables 3-1 and 3-2 for focusing lens information.

Automation | Marking Fomat | a1 |

Field Width 33465 n
Field Height 413390
Optimal Field Width 291340
Optimal Field Height 291340

Figure 3-19 Format tab drawing properties

Note: Field sizes are automatically updated when you choose a new lens in the Lens
Selection dialog box.

Field Width

Maximum field width of the currently specified focusing lens.

Field Height

Maximum field height of the currently specified focusing lens.

329
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Optimal Field Width

Nominal field width of the currently specified focusing lens.

Optimal Field Height

Nominal field height of the currently specified focusing lens.

Note: Table 3-1 and Table 3-2 lists currently available focusing lenses, nominal
(specified) and maximum field sizes for each lens, typical working distance
from the lens to the marking surface, and focused spot size.

Table 3-1 FH/Fenix lens information

Lens Specified Field ~ Maximum Field  Working Distance Spot Size
Hﬁicall 1/e?
370 mm  198.0x 198.0 mm  241.0 X 297.0 mm 368 mm 540 um
200 mm  110.0x 110.0 mm  134.0 x 165.0 mm 201 mm 290 um
125mm 740X 74.0mm  85.7 x105.6 mm 128 mm 180 wm
125HP 66.0x 66.0mm  80.4x 99.0 mm 126 mm 180 um
80mm  27.0x 27.0mm  33.5x 41.2 mm 81 mm 116 pm

Table 3-2 SH/DH lens information

Lens Specified Field Maximum Field Working Distance Spot Size
Hﬁical1 1/e?
370 mm  200.0 x 200.0 mm n/a 455 mm 540 wm
200 mm  110.0 x 110.0 mm n/a 240 mm 290 wm
125mm  70.0x 70.0 mm n/a 148 mm 180 um
69 mm  38.0x 38.0 mm n/a 70 mm 100 pm

1 The typical working distance is marked on each individual focusing lens. The actual working distance
may vary from lens to lens within £10 mm.
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Format tab object properties

Object properties (Figure 3-20) apply to objects contained within the drawing. These
properties set object positions and create object arrays for batch marking of parts.

Special | utomation | Marking Fomat | a1 |

Object Left Pos -0.7306 in -

Object Top Pos -1.0950 in

Fixed To Pasition Center

Rastet Scan Dit Wertical

Antay Columns

Antay Rows 2

Mark Array Yes

Show Anay Yes

Column Spacing 05000 in

Row Spacing 05000 in

Artay Angle 0 degress

Text Caption text

Font Type Stioke [
Stioke Font Simple

Text Height 0.2500in

Text Justification Left =

Figure 3-20 Format tab object properties

Object Left Position

Set the left (X-coordinate) position for the selected object’s bounding outline.

Object Top Position

Set the top (Y-coordinate) position for the selected object’s bounding outline.

Fixed To Position (text, bar code, and 2D Data Matrix code objects only)

Define a fixed point for positioning an object if its size is increased or decreased. One of
nine bounding outline handles can be used as an anchor point; the other bounding
outline points are free to move as scaling occurs.

Raster Scan Direction

Specify horizontal or vertical raster scanning. One scan direction may mark much faster
than the other depending on the orientation of the raster image.
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Array commands

The Array commands described below allow you to batch mark a group of parts. Select
an object or objects to be marked as an array element then create an array by specifying
rows, columns, and spacing. The batch of parts to be marked must all fit within the
marking field of the lens.

Array Columns

Enter the number of element columns in the array.

Array Rows

Enter the number of element rows in the array.

Mark Array

Toggle (yes/no) to mark the array. If No, only the original object, not the array, will
mark.

Show Array

Toggle Yes to display the selected array or No to display only a single array element.

Column Spacing

Enter the desired spacing between element columns in the array.

Row Spacing

Enter the desired spacing between element rows in the array.

Array Angle

Enter a baseline angle for rotating the array.

Polyline Filled
Fill the selected polyline object.
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Format tab text properties

Text properties (Figure 3-21) apply to text objects within the drawing. These properties
provide typographical control over specific text characteristics.

Special | Automation | Marking Fomat | ar |

Array Angle 0 degrees ]
Text Caption test

Font Typs True Type

True Type Font Times New Roman

Text Height 0.2500 in

Text Bold Yes

Text talics Yes

Text Filled Yes

Text Outine Filed Yes

Text Outine Power 50%

Text Justfication Left

Text Curve Detail 100

Text Width 0.0926 in

Line Spacing 0.2675 in

Estra Char Spacing 0.0000 in

Test Radius 0.0000 in ~

Figure 3-21 Format tab text properties

Text Caption

Contains the currently selected text to be marked. If the text displayed in the Property
List is highlighted, typing will replace any current text. To edit, click in the highlighted
field to establish an insertion point. Click the ellipsis (...) to enter multiline text in the
Text Caption Editor dialog box.

Font Type

Select either a TrueType or Stroke font for text. Use stroke fonts to mark quickly for
high throughput speeds. Use TrueType fonts to match a logo, maintain a corporate
identity, or create a certain “look”.

Stroke Font

Select one of ten Stroke fonts available in WinMark Pro. Fonts available include
European, Gothic, LiteCom, Little, Sans Serif, Simple, Trip, Tscr (Trip Script),
Complex, and Simplex.

TrueType Font

Select a TrueType font for text. Any TrueType font installed on your computer can be
laser marked.
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Text Height

Enter a base character height for text.

Text Bold
Toggle (yes/no) to bold selected text.

Text Italics

Toggle (yes/no) to italic selected text.

Text Filled

Toggle (yes/no) to fill selected text. Selecting Yes causes text characters to be filled.
Selecting No simply marks the character’s outline.

Text Outline Filled
Toggle (yes/no) to outline the edges of raster-filled TrueType fonts.

Text Outline Power

Set a power level for marking the text outline. Typically the outline power setting will
be higher than the setting used for filling text.

Text Justification

Select left, right, or center justification for multiline text objects.

Text Curve Detall

Specify a curve resolution for TrueType fonts. Applying higher values creates smoother
curves when marking large text sizes.

Text Width

Enter an average width (horizontal scale) for text characters. Enter zero (0) for the
default font width.
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Line Spacing
Enter line spacing (leading) between lines of multiline text. Enter zero (0) for the
default line spacing.

Extra Char Spacing

Enter additional spacing (tracking) between text characters. Enter zero (0) for the
default character spacing.

Text Radius

Enter a radius for marking text on a curve. Use Text Radius to fit text inside or outside
an arc or circle.

Format tab circle properties

Circle properties (Figure 3-22) apply to circle objects within the drawing. These
properties give you the ability to create circles or arcs of varying sizes.

Special | Marking Fomat | Al

Object Left Pos

06000 in

Object Top Pas

09500 in

Raster Sean Dir

Wetical

Aray Columns

2

Aray Rlows

2

Mark Ay

Tes

Show Array

Tes

Column Spacing

0.5000 in

Fow Spacing

0.5000 in

Array ngle

0 dearees

Arc Radius

0.2500 in

Arc Start

0 dearees

Arc End

360 degress

|Arc Filled

Mo

Figure 3-22 Format tab circle properties

Arc Radius

Enter an exact radius for a circular object.

Arc Start

Use Arc Start to create an arc or semicircular object by specifying a starting angle for
the object. Increase degrees to move the starting position of the arc in a clockwise

Bas
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direction from the zero point. When Arc Start is used in conjunction with Arc End, the
open arc segment can be made to point in any direction.

Arc End

Use Arc End to create an arc or semicircular object by specifying an end angle for the
object. Decrease degrees to move the ending position of the arc in a counterclockwise
direction from the zero point. When Arc End is used in conjunction with Arc Start, the
open arc segment can be made to point in any direction.

Arc Filled

Fill the selected circle.

Format tab bar code properties

Bar code properties (Figure 3-23) apply to bar code objects within the drawing. You can
select specific bar code types and customize bar code properties.

Object Left Pos

-1.5000in

QObject Top Pos

0.4250in

Fized To Position
Fiaster Sean Dir

Center
Wertical

Auray Columns

1

£uray Rows

1

arcode Number

0000

aicode Style

Code 30f 9

arcode Resolution

300

arcode Inverted

‘fes

arcode Quiet Zone Size

arcode Height

0.1000 in
0.2500 in

ardode Thin width

0.0200 in

arcode Checksum

‘fes

arcode Show Text

‘fes

arcode Text Where

Below Center

Figure 3-23 Format tab bar code properties

Barcode Number

Enter a single line bar code number.
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Barcode Style

Select from over twenty common bar code types. Supported formats include:
Codabar HIBC Code 3 of 9
Code 3 of 9 (Code39) Interleaved 2 of 5

Extended Code 3 of 9 (Code39) MSI Plessey
Code 93 Portable Data File 417
Extended Code 93 Post Net 5, 9, 11 Digit

Code 128 (all 128 characters) UCC-128

Code 128 Subset A UPC-A 11 Digit
Code 128 Subset B UPC-E 6 Digit, 0 Type Code
Code 128 Subset C UPC-E 6 Digit, 1 Type Code
Ean/Jan 8 Digit UPC-E 11 Digit

Ean/Jan 13 Digit

Barcode Resolution

Define line density for the rasterized bar code. This value is the same as the marking
resolution; higher resolution values increase marking time.

Barcode Inverted

Create a contrasting “negative-image” of the bar code. The spaces between the bars
are marked instead of the bars themselves. This feature is used when marking dark
materials that produce a lighter, contrasting mark.

Barcode Quiet Zone Size

If Barcode Inverted is selected, you can choose to create a dark outline, a quiet zone,
before and after the ends of the bar code.
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Barcode Height
Set a specific bar code height.

Barcode Thin Width

Define a line width for the thin bar in the bar code. Horizontal spacing is then propor-
tionally adjusted throughout the bar code.

Barcode Checksum

Toggle (yes/no) to include a Barcode Checksum if applicable for the Barcode Style
selected.

Barcode Show Text

Toggle (yes/no) to include human-readable text in the bar code.

Barcode Text Where

Select one of six locations for the placement of human-readable text, if included in the
bar code.

Barcode Text Font
Select any TrueType font on your computer system for the human-readable text

included in the bar code.

Note: Human-readable bar code text always uses TrueType fonts. To shorten cycle
times, set Barcode Show Text to No then create and position a text box.
Type in the Barcode Number and specify a stroke font.

Barcode Text Size

Enter a text size for the human-readable text, if included in the bar code.

Barcode Thick to Thin

Select a sizing ratio between the thick and thin bars in the bar code. Preset ratios
include 2:1, 2.5:1, and 3:1.

Bas Synrad WinMark Pro® user’s guide



technical reference

WinMark Pro object properties

Format tab 2D Data Matrix code
properties

2D Data Matrix code properties (Figure 3-24) apply to 2D Data Matrix code objects
within the drawing.

Special | Aytomation | Marking Fomat |ar |

Object Left Pos 0.6000 in
QObject Top Pos 0.8000 in
Fized To Position Center
Fiaster Sean Dir Wertical

Auray Columns 1
£uray Rows 1
arcode Text 0000
arcode Fixed Cell Size | Mo
arcode Inverted ‘fes
arcode Quiet Zone ‘fes

Figure 3-24 Format tab 2D Data Matrix code properties

2D Barcode Text

Enter single or multiline bar code text.

2D Barcode Fixed Cell Size

If 2D Barcode Fixed Cell Size is set to Yes, then the 2D bar code size is based on the
number of cells and the cell size specified by 2D Barcode Cell Size. If set to No, then
cells are sized to fit the existing bar code size.

2D Barcode Cell Size
Specify the size of each 2D bar code cell.

2D Barcode Inverted

Create a contrasting “negative-image” of the bar code. The spaces between the cells
are marked instead of the cells themselves. This feature is used when marking dark
materials that produce a lighter, contrasting mark.
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2D Barcode Quiet Zone

If 2D Data Matrix Code Inverted is selected, you can choose to create a dark outline, a
quiet zone, around the code.

Format tab spot properties
Spot properties (Figure 3-25) apply to spot objects within the drawing.

Special| Marking Fomat a1 |

Obiject Left Pos 0.0000in
Object Top Pos -1.5000 in
Raster Scan Dit ertical
Array Columns
Anay FRows
Spot Lase Duration .0000 msecs

Figure 3-25 Format tab spot properties

Spot Lase Duration

Enter a lasing duration in milliseconds. Spot Lase Duration is useful when marking a
spot or drilling a hole.

Fao
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Special tab

Special tab object properties
These properties (Figure 3-26) apply to objects contained within the drawing.

Special | Aytomation | Marking | Format| A1 |

Object Name [Textt

Figure 3-26 Special tab object properties

Object Name

Allows you to enter a specific descriptive name for each object created or imported
onto the Drawing Canvas.

All tab

Drawing and object properties

All applicable properties from the Automation, Marking, Format, and Special tabs are
automatically included in this section (Figure 3-27).

Automation | Marking | Format Al

Field Width 5 in -
Field Height 339in
Optimal Field Width n34in
ptimal Fisid Height n34in
el Offset X 0000 in

Figure 3-27 All tab properties
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Event Builder commands described below (Figure 3-28) can be called by any of four
Automation tab Drawing Events (On Before Mark Session, On After Mark Session,
On Before Mark Piece, On After Mark Piece) and are used to perform automation
functions during the marking process.

Event Builder [ %]
— Command — Command Detail
sed | s [ el |

AszzignD ate
CallDLLFunc
[DoBeep
DoPauze
IncSerial
MarkingHead0n
MatchDigitalState
FeadFromSerialPort — — Target Object and FProperty

ReadLineFromFile X
FieadyStatus Obiject Property

RestoreProperty 'ﬂ Mot used. Mot used.

()8 I Cancel

Figure 3-28 Selecting Event Builder commands

AskUserlnput

Prompts the operator for keyboard input and assigns the resulting alphanumeric string
to the specified target object and property. This keyboard input is often assigned to the
Text Caption property.

AssignDate

Allows you to create and assign a predefined or customized date code format to a
target object and property. This command string is normally assigned to the Text
Caption property.
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CallDLLFunc

Call a custom user-written Dynamic Link Library (DLL) that can be passed a property
and user arguments by specifying the DLL Filename, export Function Name, and up to
three user arguments.

To activate a DLL from WinMark, an event must be defined in the Event Builder via
the Automation tab for the drawing. The following steps are used to define the event:

1
2

W

S

-

Select the Automation tab for the drawing from the Property List.

Select the marking event to be defined, such as On Before Mark Piece, and click
the ellipsis (...).

In the Event Builder dialog box, click Add in the Commands frame.

In the field labeled I in the Commands frame, click the down arrow and select
CallDLLFunc from the drop-down list.

In the Command Details frame, enter the DLL Filename, DLL export Function
Name, and up to three user arguments.

In the Target Object and Property frame, select a target object and corresponding
object property.

Click OK. When the drawing is marked, the DLL will be activated.

To implement the DLL/WinMark interface, the DLL must use an argument that is a
structure with the following members:

struct _DLLStruct

{

char szUserArg1[64]; /l argument 1

char szUserArg2[64]; /l argument 2

char szUserArg3[64]; /l argument 3

char szPropBuffer[128];  // data buffer

WORD bBufferChanged; /I data change flag (object data
has changed in current drawing)

void* pfnFuncCallback;

void* pfnCallbackData;
HWND hwndWinMark;

|5

The export functions of the DLL must be explicitly defined in the .DEF file (e.g.
functionl @1, function2 @2).
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The sample DLL provided in the WinMark \ Samples\ SampleDIl folder reads data from
the computer’s serial port, inserts a carriage return (CR) and line feed (LF) when a new
line character is received, terminates the data input, and initiates the WinMark
marking sequence when a “MARK?” string is received. The serial data is stored in the
szPropBuffer buffer and the bBufferChanged flag is set to a non-zero value. The flag tells
WinMark that the received data should replace the current marking data. The sample

DLL takes two arguments: the com port value (e.g. com1) and the serial port timeout
value (e.g. 10000 ms).

DoBeep

Generate a beep from the computer’s speaker. This command might be used to provide
an audible prompt for user input or a signal that marking is complete.

DoPause

Pause program execution for the specified number of milliseconds.

IncSerial

Increment or decrement the numeric characters in a string by the specified delta value.
This command is normally assigned to the Text Caption property.

MarkingHeadOn

Specify an output bit pattern to be sent to parts handling equipment when the Marking
Head is powered up. Bits labeled IGNORE are not changed.

MatchDigitalState

Read the digital input bits of the Marking Head or the Fiber Link Controller Card
(FLCC). The result, 1 if all bits match, 0 if not, is assigned to the target property.
The command result is normally passed to “toggle” properties such as Mark Object to
include or exclude an object from marking. A timeout value of —1 will force the
program to wait until the Esc key aborts marking.

ReadFromSerialPort

Read a line of text from the specified serial port. The value read can be used to dynami-
cally set the value of any target property. Since one line of text is read from the serial
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port each time ReadFromSerialPort is called, you must end the line with a carriage
return to provide the End Of Line (EOL) delimiter. Communications port handshake
parameters are : 9600 baud, 8 bits, 1 stop bit, No parity, and Flow Control.

ReadLineFromFile

Read a line of text from the specified text file and assigns it to any target property.
Since one line of text is read each time ReadLineFromFile is called, you must end the
line with a carriage return to provide the End Of Line (EOL) delimiter.

ReadyStatus

Define an output signal to parts handling equipment indicating that the Marking Head
did not mark due to a fault. Bits labeled IGNORE are not changed. This command
queries Fenix and FH Series Marking Heads for status after completion of a mark and
sends the user-defined output signal if the marking head is not ready due to an error.

RestoreProperty

Restore the specified target property’s value from a disk file. The disk filename is your
Drawing filename with a .dat extension.

SaveProperty

Save the specified target property’s value to a disk file. The disk filename is your
Drawing filename with a .dat extension.

SetDigitalState

Set individual digital output bits of the Marking Head or Fiber Link Controller Card
(FLCCQC) to the specified values. Bits labeled IGNORE are not changed. Output bit 7 is
not available on the FLCC.

WaitDigitalState

Wait for a specific digital state to be read from the Marking Head’s or the Fiber Link
Controller Card’s (FLCC) input bits. Program execution continues if the required state
is met before the specified timeout interval, if not, the mark will fail. A timeout value
of —1 will force the program to wait until the Esc key aborts marking. WaitDigitalState
ignores any input bits labeled as IGNORE.
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Use information in this section to familiarize yourself with WinMark Pro’s
implementation of ActiveX control.

WinMark ActiveX control

For maximum customization and flexibility, WinMark Pro can be automated by an
ActiveX control created from a Windows development tools such as MS Access,

MS Visual Basic, MS Visual C++, or Borland Delphi 2.0. Once drawing templates are
created in WinMark Pro, you create a custom ActiveX control that would normally
perform the following tasks:

Load one or more WinMark .mkh drawings into the control

Manipulate drawing objects through property modifications or object
transformations

Synchronize with parts handling equipment
Initiate parts marking

Store and mark multiple drawings in the same session.

Sample Visual Basic and C++ programs are provided in the WinMark \ Samples\ Visual
BasicSample and WinMark \ Samples \ Visual CPlusSample folders respectively.

ActiveX control properties

Drawinglndex

The Drawinglndex property can be used to have multiple drawings stored in one
instance of the WinMark ActiveX control. Any number of drawings can be active,
limited only by available memory. The default value assigned to this property is 0. Any
operations performed on the control are performed on the active drawing. To switch to
another drawing, just assign a new number to the Drawinglndex control. Note that the
display of the control will not be updated until the Redraw method is called.
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Visual Basic example:

Mh.Drawinglndex = 0
Mh.LoadDrawing “test1.mkh”
Mh.Drawinglndex = 1
Mh.LoadDrawing “test2.mkh”
Mh.Drawinglndex = 2
Mh.LoadDrawing “test3.mkh”
Mh.Drawinglndex = 0
Mh.MarkDrawing
Mh.Drawinglndex = 1
Mh.MarkDrawing
Mh.Drawinglndex = 2
Mh.MarkDrawing

ProgressCtriHandle

The HWND ProgressCtrlHandle property can be used to display a progress bar to
users during lengthy WinMark Pro operations such as loading, saving, or marking a
document. To use this property, create a Progress Bar control on the same form as
your WinMark Pro ActiveX control and assign this property the window handle for
this control. When you no longer want to display the progress updates, assign O to the
control.

Visual Basic example:

‘ select active drawing index

mh.Drawinglndex = 0

‘ assign the progress handle
mh.ProgressCtrIHandle = ctIProgressBar.hWnd

‘ load the drawing — progress will now be displayed
mh.LoadDrawing “test.mkh”

mh.MarkDrawing

‘no more progress displays
mh.ProgressCtrIHandle = 0
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ActiveX control methods

Add2DBarCode

The Add2DBarCode control adds a new 2D Data Matrix code object to the current
drawing. Object Name is assigned as the object name for the new 2D Data Matrix
code. The control is formatted as:

BOOL Add2DBarCode < ObjectName as String, X as Float,Y as Float, Text
as String >

Visual Basic example:

mh.Add2DBarCode “2DBarCode”, 0, 0, “AB241”

AddBarCode

The AddBarCode control adds a new bar code object to the current drawing. Object
Name is assigned as the object name for the new bar code. The control is formatted as:

BOOL AddBarCode < ObjectName as String, X as Float,Y as Float, Number
as String >

Visual Basic example:

mh.AddBarCode “BarCode”, 0, 0, “12345”

AddCircle

The AddCircle control adds a new circle object to the current drawing centered at (x1,
y1) with a radius as specified. Object Name is assigned as the object name for the new
circle. The object will be created using the current default object properties as specified
in the WinMark Pro application. The control is formatted as:

BOOL AddCircle < ObjectName as String, x1 as Float, y1 as Float, radius as
Float >

Visual Basic example:

‘ create a new circle centered at (0,0) with a radius of 1
mh.AddCircle “CircleObject”, 0, 0, 1
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Addlmport

The Addimport control adds a new imported graphic to the drawing. If you are import-
ing file formats other than .dxf, .eps, .bmp, or .igs you must have previously installed
the File Import Filters library. Object Name is assigned as the object name for the new
imported graphic. The control is formatted as:

BOOL Addimport < strObjectName as String, strFileName as String>
Visual Basic example:

mh.AddImport “NewPicture”, “c:\pic.omp”

AddLine

The AddLine control adds a new line object to the current drawing using (x1, y1) as
the top-left position and (x2, y2) as the bottom right position. Object Name is assigned
as the object name for the new line. The object will be created using the current default
object properties specified in the WinMark Pro application. The control is formatted
as:

BOOL AddLine < ObjectName as String, x1 as Float, y1 as Float, x2 as
Float, y2 as Float >

Visual Basic example:

‘add new line from (-1,-1) to (1,1)
mh.AddLine “LineObject”, -1, -1, 1, 1

AddPreviewWnd

The AddPreviewWnd control opens the WinMark ActiveX dialog box showing the
drawing objects to be marked. The control is formatted as:

VOID AddPreviewWnd < pParent as long*, resourcelD as long >
Visual Basic example:

mh.AddPreviewWnd 10000, 10
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AddRect

The AddRect control adds a new rectangle object to the current drawing using (x1, y1)
as the top-left position and (x2, y2) as the bottom right position. Object Name is
assigned as the object name for the new rectangle. The object will be created using the
current default object properties as specified in the WinMark Pro application. The
control is formatted as:

BOOL AddRect < ObjectName as String, x1 as Float, y1 as Float, x2 as
Float, y2 as Float >

Visual Basic example:

‘add new rectangle from (-1,-1) to (1,1)
mh.AddRect “RectObject”, -1, -1, 1, 1

AddSpot

The AddSpot control adds a new laser spot object to the drawing. Object Name is
assigned as the object name for the new spot. The control is formatted as:

BOOL AddSpot < ObjectName as String, X as Float,Y as Float >
Visual Basic example:

mh.AddSpot “Spot”, 0, 0

AddText

The AddText control adds a new text object to the current drawing at (x1, y1). Object
Name is assigned as the object name for the new text. Text Caption is assigned as the
text caption for the new object. The object will be created using the current default
object properties as specified in the WinMark application. The control is formatted as:

BOOL AddText < ObjectName as String, x1 As Float, y1 as Float,
TextCaption as String >

Visual Basic example:

‘add a new text object at (0,0)
mh.AddText “TextObject”, 0, 0, “Hello World!”
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ClearSelection

The ClearSelection control clears the selection set in the current drawing. The control
is formatted as:

BOOL ClearSelection < none >
Visual Basic example:

mh.ClearSelection
mh.SelectObject “TextObject”
mh.ClearSelection

ConfigureAbort

The ConfigureAbort control allows you to configure the abort sequence. The ability to
abort can be turned on or off with the bEnabled parameter. It is strongly recommended
that you set this to enabled (TRUE). By default, the esc key aborts marking, however
iKey can be set to virtual any key code. When the user aborts marking, a dialog box asks
for confirmation. Use the bShowDialog parameter to turn this feature on or off. The
control is formatted as:

VOID ConfigureAbort < bEnabled as Boolean, X as Float, iKey as Integer,
bShowDialog as Boolean >

Visual Basic example:

mh.ConfigureAbort 1, VK_ESCAPE, 1

DeleteObject

The DeleteObject control deletes a specific object reference by Object Name from the
current drawing. The control is formatted as:

BOOL DeleteObject < ObjectName as String >
Visual Basic example:

‘ delete the text object named “text”
mh.DeleteObject “text”
DeleteSelection
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DeleteSelection

The DeleteSelection control deletes all objects in the current selection set from the
current drawing. The control is formatted as:

BOOL DeleteSelection < none >
Visual Basic example:

‘ deletes all objects in the current drawing
mh.SelectAll
mh.DeleteSelection

EraseDrawing

The EraseDrawing control removes all objects in the current drawing. The control is
formatted as:

BOOL EraseDrawing < none >
Visual Basic example:

mh.AddRect “rect”,0,0,1,1
mh.AddRect “rect2”, -1, -1, 0,0
mh.EraseDrawing

GetBoolProp

The GetBoolProp control gets a Boolean property from the current drawing. The
control is formatted as:

BOOL GetBoolProp < ObjectName as String, PropertyName as String >
Visual Basic example:

Dim flag as Boolean
flag = mh.GetBoolProp “TextObject”, “MarkObject”
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GetDigitalBit

The GetDigitalBit control retrieves the digital state of one of the input lines connected
to the Marking Head or FLCC. You can use these digital signals to handshake with
external hardware. The control is formatted as:

BOOL GetDigitalBit < nBit as Integer >
Visual Basic example:

‘ get state of Bit 0
mh.GetDigitalBit 0
‘ get state of Bit 1

mh.GetDigitalBit 1

GetFloatProp

The GetFloatProp control gets a float property value from the current drawing. The
control is formatted as:

FLOAT GetFloatProp < ObjectName as String, PropertyName as String >
Visual Basic example:

Dim value as single
value = mh.GetFloatProp “TextObject”, “ObjectLeftPos”

GetIntProp

The GetIntProp control gets an integer property value from the current drawing. The
control is formatted as:

INTEGER GetintProp < ObjectName as String, PropertyName as String >
Visual Basic example:

Dim value as Integer
value = mh.GetIntProp “TextObject”, “Resolution”
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GetObjectBounds

The GetObjectBounds control returns the bounding rectangle for an object. The
control is formatted as:

BOOL GetObjectBounds < Objectindex as Integer, Left ByRef Float, Top
ByRef Float, Width ByRef Float, Height ByRef
Float >

Visual Basic example:

Dim x as single
Dimy as single
Dim w as single
Dim h as single
mh.GetObjectBounds 0,x,y,w,h

GetObjectCount

The GetObjectCount control returns the object count for the currently active drawing.
The control is formatted as:

SHORT GetObjectCount < none >
Visual Basic example:

Dim n as Integer
n = mh.GetObjectCount

GetObjectindex

The GetObjectindex control returns the index number of an object in the drawing.
The control is formatted as:

INTEGER GetObjectindex < ObjectName as String>
Visual Basic example:

mh.EraseDrawing

mh.AddRect “rect”, 0, 0, 1, 1

Dim nObject as Integer

nObject = mh.GetObjectindex “rect”

Psa Synrad WinMark Pro® user’s guide



technical reference

ActiveMark™ technology

GetObjectName

The GetObjectName control returns the name of an object by index number. The
control is formatted as:

STRING GetObjectName < Objectindex as Integer >

GetObjectPos

The GetObjectPos control returns a position for an object in the drawing. You can
select the bounding outline position to be referenced from one of the following: O-top
left, 1-top right, 2-bottom right, 3—bottom left, 4—center. The control is formatted as:

BOOL GetObjectPos < Objectindex as Integer, Position as Integer, x ByRef
Float, y ByRef Float>

Visual Basic example:

Dim x as single

Dimy as single

‘ get top left
mh.GetObjectPos 0, 0, x, y
‘ get center
mh.GetObjectPos 0, 4, x, y

GetObjectType

The GetObjectType control returns the specific object type for a particular object.
Return values are: Unknown—-0, Group—1, Text-2, Polyline—3, Raster Bitmap—4,
Vector Import-5, Arc—6, Bar Code~7, Spot—8. The control is formatted as:

SHORT GetObjectType < Objectindex as Integer >
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GetSelectionBounds
The GetSelectionBounds control returns the bounding rectangle for the current

selection set. The control is formatted as:

BOOL GetSelectionBounds < Left ByRef Float, Top ByRef Float, Width
ByRef Float, Height ByRef Float >

Visual Basic example:

Dim x as single

Dimy as single

Dim w as single

Dim h as single
mh.SelectObject “rect”
mh.GetSelectionBounds x,y,w,h

GetStringProp

The GetStringProp control gets a string property value from the current drawing. The
control is formatted as:

STRING GetStringProp < ObjectName as String, PropertyName as String >
Visual Basic example:

Dim value as String
value = mh.GetStringProp “TextObject”, “TextCaption”
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LoadDrawing

The LoadDrawing control loads the specified WinMark Pro drawing into the control.
The drawing will not be displayed until the Redraw method is called. If the
ProgressCtriHandle was set to a progress bar, then the progress will be indicated as the
load proceeds. The control is formatted as:

BOOL LoadDrawing < Filename as String >
Visual Basic example:

mh.Drawinglndex = 0

mh.ProgressCtrlHandle = ctiProgressBar.hWnd
mh.LoadDrawing “hello.mkh”

mh.Redraw

mh.SaveDrawing “hellosave.mkh”

MarkDrawing

The MarkDrawing control laser marks the current drawing. If the ProgressCtriHandle
was set to a progress bar, then the progress will be indicated as the mark proceeds. The
control is formatted as:

BOOL MarkDrawing < no arguments >
Visual Basic example:

‘ select the active drawing

mh.Drawinglndex = 0

‘ enable the progress bar
mh.ProgressCtrIHandle = ctlProgressBar.hWnd
‘load the drawing

mh.LoadDrawing “hello.mkh”

“mark the drawing

mh.MarkDrawing
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MirrorSelection

The MirrorSelection control mirrors all objects in the current selection set along the
x or y-axis. The objects are mirrored about the center point of the current selection set.
The control is formatted as:

BOOL MirrorSelection < FlipX as Boolean, FlipY as Boolean >
Visual Basic example:

‘select all objects in the current drawing and mirror them across the X-

axis
mh.SelectAll
mh.MirrorSelection True, False
MoveSelectionTo

The MoveSelectionTo control moves all objects in the current selection set to the
specified (x, y) location. The top left position of the object is moved to the location.
The control is formatted as:

BOOL MoveSelectionTo < xPos as Float, yPos as Float >
Visual Basic example:

‘ select all objects in the current drawing and move them to (-1,-1)
mh.SelectAll
mh.MoveSelectionTo 1,1

Redraw

The Redraw control redraws the Drawing Canvas to reflect any changes made to the
active drawing via ActiveX control. The control is formatted as:

VOID Redraw < none>
Visual Basic example:

‘ select all objects in the current drawing and rotates them by 45 degrees
and redraws the drawing
mh.SelectAll
mh.RotateSelection 45
mh.Redraw
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RotateSelection

The RotateSelection control rotates all objects in the current selection set by the
specified angle. Positive angles are rotated clockwise while negative angles are rotated
counterclockwise. The center of rotation is the center point of the current selection set.
The control is formatted as:

BOOL RotateSelection < Angle as Integer >
Visual Basic example:

‘ select all objects in the current drawing and rotates them by 45 degrees
mh.SelectAll
mh.RotateSelection 45

SaveDrawing

The SaveDrawing control saves the current drawing. If the ProgressCtrlHandle was set
to a progress bar, then the progress will be indicated as the mark proceeds. The control
is formatted as:

BOOL SaveDrawing < Filename as String >
Visual Basic example:

‘ select the active drawing

mh.Drawinglndex = 0

‘ enable the progress bar
mh.ProgressCtrIHandle = ctIProgressBar.hWnd
‘load the drawing

mh.LoadDrawing “hello.mkh”

‘ save a new drawing

mh.SaveDrawing “hellosave.mkh”
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SelectAll

The SelectAll control selects all objects in the current drawing into the selection set.
Each drawing has a current selection set that can be used to modify one or more
objects. The control is formatted as:

BOOL SelectAll < none >

Visual Basic example:

‘ activate a specific drawing
mh.Drawinglndex = 0

‘ select all objects in the current drawing
mh.SelectAll

‘ rotate the current selection set
mh.RotateSelection 45

SelectObjectindex

The SelectObjectindex control selects an object by index number. The control is
formatted as:

BOOL SelectObjectindex < Objectindex as Integer >
Visual Basic example:

mh.EraseDrawing
mh.AddRect “rect”, 0,0, 1, 1
mh.SelectObjectindex 0

SelectObject

The SelectObject control selects an object by its name in the current drawing. The
control is formatted as:

BOOL SelectObject < ObjectName as String>
Visual Basic example:

‘ select the TextObject into the selection set
mh.ClearSelection
mh.SelectObject “TextObject”
mh.RotateSelection 45
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SetBoolProp

The SetBoolProp control assigns a Boolean value (1 or 0) to a specific property of an
object in the current drawing. ObjectName must reference a valid object in the current
drawing, and PropName must be an available property on that object. SetStringProp
can be used to assign values to any valid property, including those that require Float,
Integer, or String values. The Boolean value will be converted to the appropriate type
in these cases. The control is formatted as:

BOOL SetBoolProp < ObjectName as String, PropName as String, Value as
Boolean >

Visual Basic example:

‘ enable bolding of TextObject
mh.SetBoolProp “TextObject”, “TextBold”, 1

‘ enable raster fill of TextObject
mh.SetBoolProp “TextObject”, “TextFilled”, 1
‘ disable italics of TextObject
mh.SetBoolProp “TextObject”, “Textltalics”, 0

SetDigitalBit

The SetDigitalBit control sets a digital output bit on an output connected to the
Marking Head or FLCC. You can use these digital signals to control external hardware
or parts handling equipment. The control is formatted as:

VOID SetDigitalBit < nBit as Integer, BOOL bValue >
Visual Basic example:

‘setbit0
mh.SetDigitalBit 0, True

‘ clear bit 1
mh.SetDigitalBit 1, False
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SetFloatProp

The SetFloatProp control assigns a float value to a specific property of an object in the
current drawing. ObjectName must reference a valid object in the current drawing, and
PropName must be an available property on that object. SetStringProp can be used to
assign values to any valid property, including those that require Integer, Boolean, or
String values. The integer value will be converted to the appropriate type in these
cases. The control is formatted as:

BOOL SetFloatValue < ObjectName as String, PropName as String, Value
as Float >

Visual Basic example:

“move objectto 1.0, 1.0

mh.SetFloatProp “TextObject”, “ObjectLeftPos”, 1.0
mh.SetFloatProp “TextObject”, “ObjectTopPos”, 1.0
‘ set font height to 0.25 inches

mh.SetFloatProp “TextObject”, “TextHeight”, 0.25

SetintProp

The SetIntProp control assigns an integer value to a specific property of an object in
the current drawing. ObjectName must reference a valid object in the current drawing,
and PropName must be an available property on that object. SetStringProp can be
used to assign values to any valid property, including those that require Float, Boolean,
or String values. The integer value will be converted to the appropriate type in these
cases. The control is formatted as:

BOOL SetintProp < ObjectName as String, PropName as String, Value as
Integer >

Visual Basic example:

“ have marking output rotated by 45 degrees
mh.SetIntProp “Drawing”, “FieldRotation”, 45

‘ set 300 DPI resolution for text object
mh.SetIntProp “TextObject”, “Resolution”, 300
‘ set 2 mark passes on text object
mh.SetIntProp “TextObject”, “MarkPasses”, 2
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SetStringProp

The SetStringProp control assigns a string value to a specific property of an object in
the current drawing. ObjectName must reference a valid object in the current drawing,
and PropName must be an available property on that object. SetStringProp can be
used to assign values to any valid property, including those that require Float, Integer,
or Boolean values. The string value will be converted to the appropriate type in these
cases. The control is formatted as:

BOOL SetStringProp < ObjectName as String, PropName as String, Value
as String>

Visual Basic example:

‘ set the text caption

mh.SetStringProp “TextObject”, “TextCaption”, “Hello World!”

‘ set the text true type font

mh.SetStringProp “TextObject”, “TrueTypeFont”, “Times New Roman”

TranslateSelection

The TranslateSelection control offsets the objects in the current selection set by
specifying X offset and Y offset values. The control is formatted as:

BOOL TranslateSelection < xOffset as Float, yOffset as Float >
Visual Basic example:

‘ select all objects in the current drawing and offset them by (-1,-1)
mh.SelectAll
mh.TranslateSelection —1,-1

Synrad WinMark Pro® user’s guide Pes



technical reference

ActiveMark™ technology

WritePropListTo TextFile

The WritePropListToTextFile control writes the properties of the object specified by
strObjectName into the file specified by strFileName. The properties of the drawing can
be written out by using “drawing” for the strObjectName parameter. If the file already
exists, data is appended to the end of the file; the file is created if it does not exist. The
function returns the number of properties that were written to the file. The control is
formatted as:

LONG WritePropListToTextFile < strFileName as String, strObjectName as
String >

Visual Basic example:

mh.WritePropListToTextFile “c:\temp.txt”, “line0”
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